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Audience
This guide is intended primarily for data center administrators who use Cisco UCS Director and who have
responsibilities and expertise in one or more of the following:

• Server administration

• Storage administration

• Network administration

• Network security

• Virtualization and virtual machines

Recommended Knowledge
To deploy and manage Cisco UCS Director Bare Metal Agent, you should be familiar with the following:

• DHCP configuration

• PXE boot

• TFTP functionality

• HTTP functionality

• Linux

• Virtualization technologies
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Conventions
IndicationText Type

GUI elements such as tab titles, area names, and field labels appear in this font.

Main titles such as window, dialog box, and wizard titles appear in this font.

GUI elements

Document titles appear in this font.Document titles

In a Text-based User Interface, text the system displays appears in this font.TUI elements

Terminal sessions and information that the system displays appear in this
font.

System output

CLI command keywords appear in this font.

Variables in a CLI command appear in this font.

CLI commands

Elements in square brackets are optional.[ ]

Required alternative keywords are grouped in braces and separated by vertical
bars.

{x | y | z}

Optional alternative keywords are grouped in brackets and separated by vertical
bars.

[x | y | z]

A nonquoted set of characters. Do not use quotation marks around the string or
the string will include the quotation marks.

string

Nonprinting characters such as passwords are in angle brackets.< >

Default responses to system prompts are in square brackets.[ ]

An exclamation point (!) or a pound sign (#) at the beginning of a line of code
indicates a comment line.

!, #

Means reader take note. Notes contain helpful suggestions or references to material not covered in the
document.

Note

Means reader be careful. In this situation, you might perform an action that could result in equipment
damage or loss of data.

Caution
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Means the following information will help you solve a problem. The tips information might not be
troubleshooting or even an action, but could be useful information, similar to a Timesaver.

Tip

Means the described action saves time. You can save time by performing the action described in the
paragraph.

Timesaver

IMPORTANT SAFETY INSTRUCTIONS

This warning symbol means danger. You are in a situation that could cause bodily injury. Before you
work on any equipment, be aware of the hazards involved with electrical circuitry and be familiar with
standard practices for preventing accidents. Use the statement number provided at the end of each warning
to locate its translation in the translated safety warnings that accompanied this device.

SAVE THESE INSTRUCTIONS

Warning

Related Documentation
Cisco UCS Director Documentation Roadmap

For a complete list of Cisco UCS Director documentation, see the Cisco UCS Director Documentation
Roadmap available at the following URL: http://www.cisco.com/en/US/docs/unified_computing/ucs/
ucs-director/doc-roadmap/b_UCSDirectorDocRoadmap.html.

Cisco UCS Documentation Roadmaps

For a complete list of all B-Series documentation, see theCiscoUCS B-Series Servers Documentation Roadmap
available at the following URL: http://www.cisco.com/go/unifiedcomputing/b-series-doc.

For a complete list of all C-Series documentation, see theCiscoUCSC-Series Servers Documentation Roadmap
available at the following URL: http://www.cisco.com/go/unifiedcomputing/c-series-doc.

The Cisco UCS B-Series Servers Documentation Roadmap includes links to documentation for Cisco
UCSManager and Cisco UCSCentral. TheCiscoUCSC-Series Servers Documentation Roadmap includes
links to documentation for Cisco Integrated Management Controller.

Note

Documentation Feedback
To provide technical feedback on this document, or to report an error or omission, please send your comments
to ucs-director-docfeedback@cisco.com. We appreciate your feedback.
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Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, using the Cisco Bug Search Tool (BST), submitting a service
request, and gathering additional information, see What's New in Cisco Product Documentation.

To receive new and revised Cisco technical content directly to your desktop, you can subscribe to the What's
New in Cisco Product Documentation RSS feed. RSS feeds are a free service.
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C H A P T E R  1
New and Changed Information for this Release

This chapter contains the following section:

• New and Changed Information, page 1

New and Changed Information
The following table provides an overview of the significant changes to this guide for the current release. The
table does not provide an exhaustive list of all changes made to this guide or of all new features in this release.

Table 1: New and Changed Information for Release 6.5

Where DocumentedDescriptionFeature

Using MEMDISK for
Deploying Multiple Versions
of Windows Simultaneously,
on page 59

Now you can simultaneously deploy
different versions of Windows from a
single BMA. Earlier you could deploy
only one version of Windows
simultaneously from a single BMA.

Support for deploying different
versions of Windows
simultaneously

Uploading an OS Image File,
on page 18

Provides an option to upload the OS
images to a BareMetal Agents account
and provision the OS images.

Manage BMA Account through
UCS Director

Creating a PXE Boot Request
in Cisco UCS Director, on
page 76

Provides an option to create a PXE boot
request by choosing Administration
> Physical Accounts and clicking
Bare Metal Agents.

View and report PXE Request
Configuration

Windows Server 2016 x64
Operating System Images, on
page 54

Supports Windows Hyper-V 2016
Baremetal OS installation.

Windows 2016 - Hyper-V / OS
options

Adding a Non-Windows OS
Image in Bare Metal Agent,
on page 29

Supports vSphere/ESXi 6.5 Baremetal
OS installation.

Support for vSphere/ESXi 6.5
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Where DocumentedDescriptionFeature

Viewing the Network Interface
Details for a BareMetal Agent
Account, on page 27

Provides an option to view the Network
Interface Details for a Bare Metal
Agent Account.

Network status via GUI
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C H A P T E R  2
Overview

This chapter contains the following sections:

• Cisco UCS Director Bare Metal Agent, page 3

• Minimum System Requirements, page 3

• Guidelines and Limitations, page 4

• Network Configuration Options, page 5

• Provisioning Bare Metal Servers through Bare Metal Agent, page 7

• Upgrade of Bare Metal Agent, page 7

Cisco UCS Director Bare Metal Agent
CiscoUCSDirector BareMetal Agent (BMA) automates the process of using a Preboot Execution Environment
(PXE) to install operating systems on bare metal servers or virtual machines. Bare Metal Agent provides the
following services that are required for a functional PXE install environment:

• Dynamic Host Control Protocol (DHCP)

• Hypertext Transfer Protocol (HTTP)

• Trivial File Transfer Protocol (TFTP)

When this environment is operational and BareMetal Agent and Cisco UCSDirector are correctly configured,
you can build PXE installation tasks into any Cisco UCS Director infrastructure workflow.

You can access Bare Metal Agent through Secure Shell (SSH). You can also perform services on Bare Metal
Agent, such as DHCP configuration and starting and stopping services, through Cisco UCS Director. A single
Cisco UCS Director node can support multiple Bare Metal Agent applications.

Minimum System Requirements
For proper installation and operation of Bare Metal Agent, your environment must meet the minimum system
requirements.

Cisco UCS Director Bare Metal Agent Installation and Configuration Guide, Release 6.5    
3



Minimum Requirements for VMware vSphere

RequirementsName

4.0 and laterVMware vCenter Server

Minimum number of CPUs—2

Memory—3 GB

Hard disk—40 GB

Minimum reservation in VMware
vCenter

Minimum Requirements for Microsoft Hyper-V

RequirementsName

Windows Server 2008 R2 or Windows Server 2012 with one of the
following:

• 2.0

• 3.1

Hyper-V

Minimum number of CPUs—2

Memory—3 GB

Hard disk—40 GB

Minimum reservation in Hyper-V

Guidelines and Limitations
Before you install Bare Metal Agent, take note of the following guidelines and limitations.

Bare Metal Agent Connections

Each Bare Metal Agent application can connect to only one Cisco UCS Director node.

Network Availability

After installation and configuration, your environment must have the following network availability:

• Bare Metal Agent must be able to reach Cisco UCS Director over the network.

• Cisco UCS Director must be able to reach Bare Metal Agent over the network.

• The bare metal servers (blade or rack) must be able to reach the DHCP network of the Bare Metal Agent
during the initial stage of operating system installation over PXE.

DHCP Configuration

If you use DHCP, locate a DHCP server in the same PXE VLAN as Bare Metal Agent. Then configure that
DHCP server with the IP address range required by your DHCP server.

   Cisco UCS Director Bare Metal Agent Installation and Configuration Guide, Release 6.5
4

Overview
Guidelines and Limitations



VLAN Configuration

When setting up the network configuration, the most common configuration uses one PXE VLAN and one
Management VLAN (separate VLANs). However, Bare Metal Agent supports one VLAN for both, if you
prefer.

Configure the VLANs end-to-end between Cisco UCS, Cisco UCSDirector, and BareMetal Agent. However,
when you configure Bare Metal Agent, do not assume that routing occurs between the PXE_VLAN Layer 2
network and the Management VLAN network.

If you configure Bare Metal Agent to use DHCP, locate and configure the DHCP server in the PXE VLAN
and its subnet. This DHCP server serves the transient IP address required for the PXE process. In an environment
with two VLANs, the server is allocated an IP address from the subnet of the Management VLAN. An IP
address pool managed by Cisco UCS Director assigns this IP address.

If you configure Bare Metal Agent with two VLANs, set up two IP address attributes:

• An IP address for Bare Metal Agent in the PXE VLAN

• A second IP address for Bare Metal Agent in the Management VLAN

TFTP Server

With BareMetal Agent, use the Cisco UCSDirector TFTP server to ensure that configurations such as dynamic
variables function properly.

When you add a Bare Metal Agent account, Bare Metal Agent configures the TFTP server when services are
started.

Network Configuration Options
You can choose between the following network configuration options for Bare Metal Agent

• Single network for management and Preboot Execution Environment (PXE)

• Separate networks for management and PXE

Choose the network configuration option that best meets the requirements of your environment.

Single Network for Management and PXE

We recommend that you choose this network configuration option if your environment permits the following
to be hosted on the same VLAN (Layer 2) network (see the following figure):

• Services provided by Bare Metal Agent, such as DHCP, TFTP, and HTTP
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• Management traffic between Bare Metal Agent and Cisco UCS Director or other devices and appliances

Figure 1: Sample Topology for a Single Network

Separate Networks for Management and PXE

We recommend that you choose this network configuration option if your environment does not permit the
following to be hosted on the same network interface and Layer 2 network (see the following figure):

• On the PXE network, services provided by Bare Metal Agent, such as DHCP, TFTP, and HTTP

• On theManagement network, traffic between BareMetal Agent and Cisco UCSDirector or other devices
and appliances

Figure 2: Sample Topology for Separate PXE and Management Networks
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Prerequisites and Assumptions for a Network Configuration

Make sure that your environmentmeets the following prerequisites for BareMetal Agent network configuration:

• Cisco UCS Director has been installed and the network interface configured, as described in the
appropriate Cisco UCS Director installation guide.

• Cisco UCS Director Bare Metal Agent is reachable through a web browser and you can log in.

• Bare Metal Agent has been installed, and no additional configuration has been performed.

• For a single network configuration, make sure that the required single Management and PXE VLAN is
provisioned and available as a virtual port group or port profile that virtual machines (VMs) can be
attached to or leveraged.

• For a separate network configuration, make sure that the following networks are provisioned and available
as a virtual port group or port profile that VMs can be attached to or leveraged:

◦Management (MGMT) network—Used for traffic between Bare Metal Agent and Cisco UCS
Director

◦PXE network—Used for PXE services traffic, such as DHCP, HTTP, and TFTP

Provisioning Bare Metal Servers through Bare Metal Agent
The process involved in installing operating systems on bare metal servers through Bare Metal Agent is as
follows:

• Install Bare Metal Agent. See Installing Cisco UCS Director Bare Metal Agent, on page 9.

• Configure Bare Metal Agent. See Configuring Cisco UCS Director Bare Metal Agent, on page 13.

• Add OS images in Bare Metal Agent. See Adding Windows OS Images, on page 35 or Adding
Non-Windows OS Images, on page 29.

• Deploy OS images on bare metal servers through workflow tasks. See Provisioning OS Images through
Orchestration Workflow Tasks, on page 63.

For managing Bare Metal Agent operations through Cisco UCS Director, see Managing Bare Metal Agent,
on page 23.

Upgrade of Bare Metal Agent
For detailed information on upgrading Bare Metal Agent, see the Cisco UCS Director Upgrade Guide.
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C H A P T E R  3
Installing Cisco UCS Director Bare Metal Agent

This chapter contains the following sections:

• Installing Cisco UCS Director Bare Metal Agent on VMware vSphere, page 9

• Installing Cisco UCS Director Bare Metal Agent on Microsoft Hyper-V, page 10

Installing Cisco UCS Director Bare Metal Agent on VMware
vSphere

Before You Begin

• You must have system administrator privileges for VMware vSphere or vCenter.

• If you want to use a static IP address rather than DHCP, you must know the following information:

◦IP address

◦Subnet mask

◦Default gateway

Procedure

Step 1 On the Cisco.com download site for Cisco UCS Director, download Cisco UCS Director Bare Metal Agent
and unzip the OVF file.

Step 2 Log in to VMware vSphere Client.
Step 3 In the Navigation pane, click the vSphere host on which you want to deploy Cisco UCS Director Bare Metal

Agent.
Step 4 Choose File > Deploy OVF Template.
Step 5 On the Source screen of the Deploy OVF Template window, do one of the following to choose your OVF

source location and then click Next:

• If the OVF file is stored on your local computer, browse to the location, choose the file, and clickOpen.
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• If the OVF file is stored on a server on your local area network, enter the location of the file including
the IP address or fully qualified domain name of the server.

Step 6 On the OVF Template Details screen, verify the details and click Next.
Step 7 On the End User License Agreement screen, review the license agreement and click Accept.
Step 8 On the Name and Location screen, do the following:

a) In the Name field, enter a unique name for the VM.
b) In the Inventory Location area, choose the location where you want the VM to reside.
c) Click Next.

Step 9 On the Storage screen, choose the storage location for the VM and click Next.
Step 10 On theDisk Format screen, clickNext to accept the default radio button for Thick Provision (Lazy Zeroed)

format.
Step 11 On the Network Mapping screen, choose the network for the VM and click Next.
Step 12 On the Properties screen, do the following:

a) Configure the IP addresses for both the NICs (eth0 and eth1) that you want to assign, as follows:

• To use DHCP to assign the IP addresses, leave the default of 0.0.0.0 in the IP address fields.

• To use static IP addresses, enter the desired IP addresses in the IP address fields. If you only want
to configure one NIC, only complete one set of IP addresses and leave the second set at the default.

b) Click Next.

Step 13 On the Ready to Complete screen, verify the settings and click Finish.
A message appears to indicate that Cisco UCS Director Bare Metal Agent is being deployed.

Step 14 On the Navigation pane, right-click the VM host and choose Edit Settings.
Step 15 Make sure that the VM host has sufficient resources to power on.

For more information about the required resources, see Minimum System Requirements, on page 3.

Step 16 Power on the VM.

Installing Cisco UCS Director Bare Metal Agent on Microsoft
Hyper-V

We recommend that you deploy Cisco UCS Director Bare Metal Agent on the Hyper-V Manager host,
rather than the Microsoft System Center Virtual Machine Manager (SCVMM) console.

Note

Before You Begin

• You must have system administrator privileges for Microsoft Hyper-V.

• If you want to use a static IP address rather than DHCP, you must know the following information:

   Cisco UCS Director Bare Metal Agent Installation and Configuration Guide, Release 6.5
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◦IP address

◦Subnet mask

◦Default gateway

Procedure

Step 1 On the Cisco.com download site for Cisco UCS Director, download Cisco UCS Director Bare Metal Agent
and unzip the *.vhd file into a folder.

Step 2 Log into the Hyper-V host.
Step 3 Choose Start > Administrative Tools to open Hyper-V Manager.
Step 4 On the Hyper-V Manager screen, choose Action > New Virtual Machine.
Step 5 In the Before You Begin pane, click Next to accept the custom configuration option.
Step 6 In the Specify Name and Location pane, enter a unique name for the virtual machine (VM) name in the

Name field.
Step 7 In the Name and Location pane, do the following:

a) Check the Store the virtual machine in a different location checkbox.
b) Enter the alternate location.
c) Click Next.

Step 8 In the Assign Memory pane, enter the amount of memory to allocate to this VM (3 GB minimum) and click
Next.

Step 9 In theConfigure Networking pane, in theConnection field, clickNext to accept theNot Connected default
option.

Step 10 In the Connect Virtual Hard Disk pane, click Next to accept the Attach a virtual disk later default option.
Step 11 In the Completing the New Virtual Machine Wizard pane, verify the settings and click Finish.
Step 12 In the left pane, right-click the VM and choose Edit Settings.
Step 13 Delete the existing network adapter and click Apply.
Step 14 In the Navigation pane, click Processor.
Step 15 In the Number of virtual processors field, enter 2 vCPU.
Step 16 In the Navigation pane, click Add Hardware.
Step 17 In the Add Hardware pane, choose the Legacy Network Adapter and click OK.
Step 18 In the Legacy Network Adapter pane, in the Virtual Switch drop-down list, choose the virtual network

device.
Step 19 In the Navigation pane, click IDE Controller.
Step 20 In the IDE Controller pane, choose Hard Drive and click Add.
Step 21 Browse to the .vhd file and choose it.
Step 22 Click Apply, and then click OK.
Step 23 Power on the VM to configure network properties.

Optionally, you can configure network properties from the Shell Admin.

Only when a BMA appliance is associated with a Cisco UCS Director, the dbkeys and dbcreds files
are copied to a specific location in the BMA appliance to establish successful connectivity to the
Cisco UCS Director. After installing the BMA, you need to add the BMA appliance to Cisco UCS
Director.

Note
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What to Do Next

After Cisco UCS Director Bare Metal Agent has started, configure DHCP or a static IP address.
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C H A P T E R  4
Configuring Cisco UCS Director Bare Metal Agent

This chapter contains the following sections:

• Adding a Bare Metal Agent Account, page 13

• Configuring the DHCP Server for a Bare Metal Agent Account, page 15

• Associating a Bare Metal Agent to Cisco UCS Director, page 16

• Configuring the Interface for the PXE Network, page 17

• Adding an NFS Mount Point, page 18

• Uploading an OS Image File, page 18

• Viewing and Editing the OS Configuration File Details, page 20

• Cloning an OS Configuration File, page 20

• Swapping the OS Configuration File Details, page 21

• Provisioning an OS Image, page 21

Adding a Bare Metal Agent Account
Before You Begin

Before you add a Bare Metal Agent account, do the following:

• Make sure that the Bare Metal Agent is installed.

You are not prompted to enter the BMA root passwords during installation. However,
the first time you log in to Cisco UCS Director after installation is completed, you are
prompted to enter the default root password. The default password is pxeboot.

Note

• Make sure that the Bare Metal Agent VM is completely booted up, login to Bare Metal Agent VM
Console to view the Management IP address.
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• Login to Bare Metal Agent through VM Console or SSH client to access the CLI and change the default
root password using the passwd root command.

• Set up the environment required to support a single or separate PXE and Management network
configuration, with the appropriate VLANs.

• To provide required DHCP services, ensure that the PXE interface of the Bare Metal Agent is connected
to PXE VLAN network and configure DHCP service with an appropriate IP address range.

Procedure

Step 1 Choose Administration > Physical Accounts.
Step 2 On the Physical Accounts page, click Bare Metal Agents.
Step 3 On the Add Bare Metal Agent Appliance screen complete the following fields:

DescriptionName

The name you assign to this Bare Metal Agent
account.

Account Name field

(Optional) A description of this Bare Metal Agent.Description field

Check this box if your configuration uses separate
networks for the PXE server and the management
network that hosts the traffic manager.

Bare Metal Agent uses different interfaces for
mgmt and PXE traffic check box

The IP address assigned to the Management network
for Bare Metal Agent. If your configuration uses a
single network for the Management and PXE
networks, this IP address is automatically assigned
as the PXE address.

This address must be reachable from Cisco
UCS Director.

Note

Management/PXE Address field

The IP address for the Bare Metal Agent PXE
network, if your configuration uses separate networks.

This field appears only if the Bare Metal
Agent uses Different Interfaces for
Management and PXE Traffic box has
been checked.

Note

PXE Interface Address field

An account with administrative privileges that you
can use to log in to Bare Metal Agent.

Login ID field

The password for the account.Password field

Samba is used for Bare Metal Agent to install
Windows Operating Systems. Check this box if you
want to install Windows Operating Systems.

Enable Samba service for Windows PXE check
box

Enter the password for the Samba service.Samba Password field
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DescriptionName

Confirm the password for the Samba service.Confirm Samba Password field

(Optional) The location of this Bare Metal Agent,
such as a physical location.

Location field

Bare Metal Agent requires access to the Cisco UCS
Director database. Choose the IP address of Cisco
UCS Director which is on the same Management
network as the Bare Metal Agent.

If you are configuring the Bare Metal Agent
for the Cisco UCS Director multi-node
deployment, choose the IP address of the
Inventory Database node.

Note

Database Address drop-down list

Step 4 Click Submit.

What to Do Next

Configure the DHCP Server for Bare Metal Agent.

Configuring the DHCP Server for a Bare Metal Agent Account

For a multi-home DHCP configuration, use this procedure to configure the first subnet for the DHCP
server. For the remaining subnets, you must manually edit the DHCP configuration file
(/etc/dhcpd.conf).

Note

Before You Begin

To provide required DHCP services, ensure that at least one DHCP server is located in the same PXE VLAN
as Bare Metal Agent. Configure the DHCP server with an appropriate IP address range. The DHCP server,
together with the TFTP server, is used to communicate with a PXE server.

Procedure

Step 1 Log in to the Cisco UCS Director server with the following credentials:
a) User—admin
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b) Password—admin

Step 2 Choose Administration > Physical Accounts.
Step 3 On the Physical Accounts page, click Bare Metal Agents.
Step 4 Click the row for the Bare Metal Agent account for which you want to configure the DHCP server.
Step 5 Click Service Status to verify that services for the Bare Metal Agent account are stopped.
Step 6 Click Configure DHCP.
Step 7 On the Configure DHCP screen, complete the following fields and click Submit.

• DHCP Subnet

• DHCP Netmask

• DHCP Start IP

• DHCP End IP

• Router IP Address

The DHCP IP address assignments are updated, and the DHCP service is restarted.

Step 8 Click the row for the Bare Metal Agent account and click Start Services.
Step 9 After the services have started, do the following:

• Verify that the status of the account in the Status column is Active.

• Verify that the Enabled Services column shows that all services are running. If this status indicates that
one or more services are stopped, verify the configuration of your DHCP server and try again.

• Click Service Status to verify that the status of all expected services is up:

◦Network Services status in the Bare Metal Agent appliance

◦Database connectivity status from the Bare Metal Agent appliance

When there is no dedicated PXE boot network configured in the Bare Metal Agent and only one
Management interface is used for PXE boot, then the DHCP Server IP range should be different from
the IP range used in MGMT IP pool for cluster creation in Cisco UCS Director Express for Big Data.

Note

What to Do Next

Set up PXE boot requests.

Associating a Bare Metal Agent to Cisco UCS Director
To establish a connection between the Bare Metal Agent and Cisco UCS Director, you need to associate the
Bare Metal Agent to Cisco UCS Director.
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Procedure

Step 1 Log in to Cisco UCS Director deployed with the compatible version of the Bare Metal Agent.
Step 2 Choose Administration > Physical Accounts.
Step 3 On the Physical Accounts page, click Bare Metal Agents.
Step 4 Add a Bare Metal Agent account. See Adding a Bare Metal Agent Account, on page 13.
Step 5 Click the row for the Bare Metal Agent account and click Start Services. It might take around two minutes

for the services to start.
Step 6 After the services have started, verify that the status of the account in the Status column is Active. It might

take two minutes for the status to reflect as Active. When status of the BMA service is active, the BMA is
ready for use.

Only when the BMA services are started from the Cisco UCS Director UI, the dbkeys and dbcreds
files are copied to a specific location in the BMA appliance to establish successful connectivity to
the Cisco UCS Director.

Note

Configuring the Interface for the PXE Network
You can use this to change or add an IP address for the PXE network used by Bare Metal Agent.

Procedure

Step 1 Choose Administration > Physical Accounts.
Step 2 On the Physical Accounts page, click Bare Metal Agents.
Step 3 Click the row for the Bare Metal Agent account for which you want to configure the interface for the PXE

network.
Step 4 Click Configure Interface.
Step 5 On the Configure PXE Interface screen, complete the following fields:

a) From the Interface Name drop-down list, choose the interface that you want to use for the PXE network.
b) Enter the IP address and subnet mask for the PXE network.
c) Click Submit.
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Adding an NFS Mount Point
Procedure

Step 1 Choose Administration > Physical Accounts.
Step 2 On the Physical Accounts page, click Bare Metal Agents.
Step 3 Click the row for the Bare Metal Agent account for which you want to view PXE service requests.
Step 4 Click View Details.
Step 5 Click NFS Mount Point.
Step 6 Click Add.
Step 7 On the Add NFS Mount Point screen, do the following:

a) In the NFS Server IP Address field, enter the IP address of the NFS server where you plan to store the
OS images for Bare Metal Agent to use.

b) In the NFS Server Path field, enter the location on the NFS server where the OS images are stored.
c) Click Submit.
After you add the NFS mount point, all content in the imageRepository folder in the NFS server is
available under the /mnt/external folder. You include this path in the isoExtractor.sh file when
you create a non-Windows image template.

Uploading an OS Image File
Procedure

Step 1 Choose Administration > Physical Accounts.
Step 2 On the Physical Accounts page, click Bare Metal Agents.
Step 3 Click the row for the Bare Metal Agent account for which you want to upload the OS image.
Step 4 From theMore Actions drop-down list, click View Details.
Step 5 Click Image Repository.
Step 6 Click Upload Image.
Step 7 On the Image Upload screen, complete the following fields:

DescriptionName

The name of the OS image.Image Name field

Choose the OS image type that you want to install on the server. The
drop-down list includes all OS types supported by the Bare Metal Agent.

OS Type drop-down list
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DescriptionName

Choose one of the following:

• Desktop File

• The web server path that is reachable by the Cisco UCSDirector Bare
Metal Agent to upload remote software to Bare Metal Agent.

Upload Type drop-down list

This field is displayed when you choose the Desktop File option in the
Upload Type drop-down list.

To upload the file, you can either drag and drop the required file or click
Select and click Submit.

File field

This field is displayed when you choose the Web Server Path option in the
Upload Type drop-down list.

Enter the web server path where the ISO images are stored and click
Submit.

Web URL field

This field is displayed when you choose the Web Server Path option in the
Upload Type drop-down list.

(Optional) Enter the MD5 checksum value of the downloaded file which
is used to verify the data integrity.

MD5 Checksum field

Step 8 Click Submit. The details of the uploaded image is displayed.
Step 9 Click the row for the OS image for which you want to view the upload log details.
Step 10 Click Show Upload Log. The upload log details of the image is displayed.
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Viewing and Editing the OS Configuration File Details
Procedure

Step 1 Choose Administration > Physical Accounts.
Step 2 On the Physical Accounts page, click Bare Metal Agents.
Step 3 Click the row for the Bare Metal Agent account.
Step 4 From theMore Actions drop-down list, click View Details.
Step 5 Click OS Catalogs.
Step 6 Click the row for the OS catalog for which you want to view the configuration details.
Step 7 Click View Configuration Files.
Step 8 On the View Configuration Files screen, choose a file. The configuration details for the file are displayed.
Step 9 Click the row for the OS catalog for which you want to edit the configuration details and click Edit

Configuration Files.
Step 10 On theModify Configuration Files screen, choose the required file from the Select the file drop-down list

and make the necessary changes.
Step 11 Click Submit.

You can delete the configuration details by clicking View Configuration Files.

Cloning an OS Configuration File
Procedure

Step 1 Choose Administration > Physical Accounts.
Step 2 On the Physical Accounts page, click Bare Metal Agents.
Step 3 Click the row for the Bare Metal Agent account.
Step 4 From theMore Actions drop-down list, click View Details.
Step 5 Click OS Catalogs.
Step 6 Click the row for the OS catalog for which you want to clone the configuration details.
Step 7 Click Clone Configuration Files.
Step 8 On the Clone Configuration Files screen, do the following:

a) Choose a file from the Select the file drop-down list.
b) Enter a unique name for the file.
c) Click Submit.
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Swapping the OS Configuration File Details
Procedure

Step 1 Choose Administration > Physical Accounts.
Step 2 On the Physical Accounts page, click Bare Metal Agents.
Step 3 Click the row for the Bare Metal Agent account.
Step 4 From theMore Actions drop-down list, click View Details.
Step 5 Click OS Catalogs.
Step 6 Click the row for the OS catalog for which you want to swap the configuration details.
Step 7 Click Swap Configuration Files.
Step 8 On the Swap Configuration Files screen, choose the files whose details need to be swapped.
Step 9 Click Submit.

Provisioning an OS Image
Procedure

Step 1 Choose Administration > Physical Accounts.
Step 2 On the Physical Accounts page, click Bare Metal Agents.
Step 3 Click the row for the Bare Metal Agent account for which you want to upload the OS image.
Step 4 From theMore Actions drop-down list, click View Details.
Step 5 Click Image Repository.
Step 6 Click the row for the OS image that you want to provision.
Step 7 Click Provision Image.
Step 8 On the Provision Image Catalog screen, complete the following fields:

DescriptionName

Choose the OS image type that needs to be provisioned in the Bare Metal
Agent. The drop-down list includes all the available OS types with details
such as version and update number.

OS Type drop-down list

Enter the catalog name.Catalog Name field

Step 9 Click Provision Image.
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C H A P T E R  5
Managing Bare Metal Agent

This chapter contains the following sections:

• Changing the Default Bare Metal Agent Account, page 23

• Starting and Stopping Bare Metal Agent Services, page 24

• Checking the Status of a Bare Metal Agent, page 24

• Viewing the DHCP Configuration for a Bare Metal Agent Account, page 25

• Viewing the DHCP Logs for a Bare Metal Agent Account, page 25

• Viewing the Logs for a Bare Metal Agent Account, page 25

• Viewing Operating System Images, page 26

• Viewing PXE Service Requests, page 26

• Viewing the Network Interface Details for a Bare Metal Agent Account, page 27

• Shelladmin Script for Bare Metal Agent, page 27

• Setting Up UEFI as Network Boot Manager, page 28

Changing the Default Bare Metal Agent Account
The first Bare Metal Agent account that you create is designated as the default account. This account is used
by default in legacy workflows. To use a different account in the legacy workflows, you must designate that
Bare Metal Agent account as the default.

Procedure

Step 1 Choose Administration > Physical Accounts.
Step 2 On the Physical Accounts page, click Bare Metal Agents.
Step 3 Click the row for the Bare Metal Agent account that you want designate as the default.
Step 4 Click Set Default BMA.
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Starting and Stopping Bare Metal Agent Services
Procedure

Step 1 Choose Administration > Physical Accounts.
Step 2 On the Physical Accounts page, click Bare Metal Agents.
Step 3 Click the row for the Bare Metal Agent account whose services you want to start or stop.
Step 4 Click one of the following:

• Start Services

• Stop Services

Step 5 Click Service Status and check the status displayed in the Enabled Services column to ensure that services
have started or stopped as desired.
If services do not start, check the status displayed in the Enabled Services column. If this status indicates
that services are not enabled, verify the configuration of your DHCP server and try again.

Checking the Status of a Bare Metal Agent
Procedure

Step 1 Choose Administration > Physical Accounts.
Step 2 On the Physical Accounts page, click Bare Metal Agents.
Step 3 Click the row for the Bare Metal Agent account whose status you want to check.
Step 4 To see if services for the Bare Metal Agent account are Active or Inactive, check the Status column.
Step 5 To check the status of the services, click Service Status.
Step 6 To view the SSH-based test connection status, check the Reachable column.
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Viewing the DHCP Configuration for a Bare Metal Agent Account
Procedure

Step 1 Choose Administration > Physical Accounts.
Step 2 On the Physical Accounts page, click Bare Metal Agents.
Step 3 Click the row for the Bare Metal Agent account for which you want to view the DHCP configuration.
Step 4 Click View DHCP Configuration.

You might need to click the Down arrow at the end of the button bar to access theViewDHCPConfiguration
option.

TheView DHCP Server Configurationwindow displays the contents of the DHCP server configuration file
for the account.

Viewing the DHCP Logs for a Bare Metal Agent Account
Procedure

Step 1 Choose Administration > Physical Accounts.
Step 2 On the Physical Accounts page, click Bare Metal Agents.
Step 3 Click the row for the Bare Metal Agent account for which you want to view the DHCP logs.
Step 4 Click the down arrow at the end of the button bar and choose View DHCP Logs.

The View Bare Metal Agent DHCP Log window displays the contents of the DHCP server logs for the
account.

Viewing the Logs for a Bare Metal Agent Account
Procedure

Step 1 Choose Administration > Physical Accounts.
Step 2 On the Physical Accounts page, click Bare Metal Agents.
Step 3 Click the row for the Bare Metal Agent account for which you want to view the logs.
Step 4 Click the down arrow at the end of the button bar and choose View BMA Logs.

The View Bare Metal Agent Log window displays the logs for the account.
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Viewing Operating System Images
You can view a list of the operating system (OS) images that have been created and are available for a Bare
Metal Agent account.

Procedure

Step 1 Choose Administration > Physical Accounts.
Step 2 On the Physical Accounts page, click Bare Metal Agents.
Step 3 Click the row for the Bare Metal Agent account for which you want to view OS images.
Step 4 Click View Details.
Step 5 Click BMA OS List.

Viewing PXE Service Requests
You can view information about PXE requests made through a workflow that have an associated service
request. You cannot view details of PXE requests that are not made through a workflow, as those requests
are not associated with a service request.

The information provided about each PXE request includes the following:

• Service request ID

• Request type

• User who initiated the request

• Name of the catalog or workflow that was used to create the request

• Any comments provided by the user who initiated the request

• Time of the request

• Status of the request

• Rollback type, if applicable

Procedure

Step 1 Choose Administration > Physical Accounts.
Step 2 On the Physical Accounts page, click Bare Metal Agents.
Step 3 Click the row for the Bare Metal Agent account for which you want to view PXE service requests.
Step 4 Click View Details.
Step 5 Click PXE Service Requests.
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Viewing the Network Interface Details for a Bare Metal Agent
Account

Procedure

Step 1 Choose Administration > Physical Accounts.
Step 2 On the Physical Accounts page, click Bare Metal Agents.
Step 3 Click the row for the Bare Metal Agent account for which you want to view the network interface details.
Step 4 Click the down arrow at the end of the button bar and choose View Details.
Step 5 Click Network Interface Summary. The network interface details are displayed.

Shelladmin Script for Bare Metal Agent
Procedure

Step 1 Navigate to /opt/infra/bin.

Step 2 Run shelladmin script.

Example:
The following list of services appears:

1) Display Services Status
2) Stop Services
3) Start Services
4) Display Samba Service
5) Stop Samba Service
6) Start Samba Service
7) Change Samba Password
8) Time Sync
9) Ping Hostname/IP Address
10) Show Version
11) Configure Network Interface
12) Display Network Details
13) Add DNS Server
14) Tail Network Services Logs
15) Tail DHCP Logs
16) Change DHCP Configuration
17) Run IsoExtractor Script
18) Apply Patch
19) Shutdown Appliance
20) Reboot Appliance
21) Change Root Password
22) UCSD appliance connection
23) Quit

Step 3 Choose the required option and press Enter.
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Setting Up UEFI as Network Boot Manager
The following are the list of operating system supported for UEFI booting:

•Windows Server 2012, Windows Server 2012 R2, and Windows Server 2016

• ESXi 6.5 and ESXi 6.0

• RHEL 7.0 and above

• Centos 7.0 and above

• SLES 12 and above

RHEL 7.3 and Centos 7.3 installation are not supported for UEFI booting. OS kernels which are not
compiled with EFI stub are also not supported.

Note

Procedure

Step 1 Create a catalog from the Bare Metal Agent 6.5.
For Non-Windows operating system, provision the OS image from the Cisco UCS Director UI or
run isoExtractor.sh available in /opt/infra folder. See, Configuring Cisco UCS Director Bare
Metal Agent, on page 13. However, for Windows operating system, ensure that ipxe-uefi.cfg
and autounattend-uefi.xml files are available in the catalog.

Note

Step 2 Choose iPXE-UEFI as the network boot manager. See, Provisioning OS Images through Orchestration
Workflow Tasks, on page 63.

iPXE-UEFI supports TFTP protocol by default. However, you can modify the ipxe-uefi.cfg
with the following details to support the HTTP protocol. HTTP protocol with UEFI does not work
on all servers.

#!ipxe
initrd http://$PXE_NATIVE_WEBSERVER/$PXE_OS/isolinux/initrd.img
kernel http://$PXE_NATIVE_WEBSERVER/$PXE_OS/isolinux/vmlinuz initrd=initrd.img
ks=$PXE_KS_URL net.ifnames=0 biosdevname=0
initrd http://$PXE_NATIVE_WEBSERVER/$PXE_OS/isolinux/initrd.img
boot

Note
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C H A P T E R  6
Adding Non-Windows OS Images

This chapter contains the following sections:

• Adding a Non-Windows OS Image in Bare Metal Agent, page 29

• Manually Adding a Linux OS Image in Bare Metal Agent, page 31

• Manually Adding a VMware vSphere ESXi OS Image in Bare Metal Agent, page 32

Adding a Non-Windows OS Image in Bare Metal Agent
This procedure creates a Non-Windows OS image template in Bare Metal Agent. You must add the OS image
template before you can request a PXE boot for the OS image.

You cannot use this procedure to create supportedWindows operating systems images. Formore information
about how to set up Windows OS images, see Adding Windows OS Images, on page 35.

Note

Before You Begin

You must have all resources and requirements in place for each operating system image that you want to
install through a Bare Metal Agent PXE boot request.

Procedure

Step 1 Copy the OS image(s) to one of the following locations:

• An appropriate location in the Bare Metal Agent directory structure

• An NFS mount point that you have added to Bare Metal Agent

Step 2 Navigate to /opt/infra and run isoExtractor.sh.

Example:
The following sample isoExtractor.sh file shows a scenario for an OS image in the BareMetal Agent directory
structure. The image path field contains the location of the VMware image in the /opt/image/ folder.
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If you have added an NFS mount point, the image path field would contain the location of the image in the
/mnt/external folder. For example, if you want to create a CentOS image that is located in a CentOS
folder in anNFSmount point, the image path field would contain/mnt/external/CentOS/image.iso.

root@localhost infra]# pwd
/opt/infra
root@localhost infra]# ./isoExtractor.sh

Please select the OS Type

1) ESXi 4.1
2) ESXi 5.0
3) ESXi 5.1
4) ESXi 5.5
5) ESXi 6.0
6) ESXi 6.5
7) ESXi 5.5 VSAN
8) ESXi 6.0 VSAN
9) CentOS or RHEL [Pre 7.0]
10) CentOS 7.x or RHEL 7.x
11) SUSE Linux
12) Other

SELECT> 4
Image path : /opt/image/VMWare-VMvisor-Installer-5.5.0-1111111.x86_64.iso

OS catalog name : BMA-184-ESXi5.5
Input file being used: /opt/images/VMware-VMvisor-Installer-5.5.0-1111111.x86_64.iso
OS catalog name being used: BMA-184-ESXi5.5
Mounting the image....
Preparing the image....
Creating catalog directory /opt/cnsaroot/templates/BMA-184-ESXi5.5
Creating configuration files for ESXi 5.5 ...
Copied the image and created the configuration files...
is /opt/cnsaroot/images/
BMA-184-ESXi5.5 centos60-small
is /opt/cnsaroot/templates/
BMA-184-ESXi5.5 CentOS60 Win2k12R2x64 Win2k12x64 Win2k8R2x64
is /opt/cnsaroot/templates/BMA-184-ESXi5.5
boot.cfg ks.cfg pxe.cfg
[root@localhost infra]#

Step 3 When prompted, choose the image category and provide the image location and catalog name.
Step 4 After the script execution is completed, navigate to /opt/cnsaroot/images/catalogname and

confirm that the image is available in that location.
Step 5 Navigate to /opt/cnsaroot/templates/catalogname and confirm that the PXE configuration

templates are available in that location.
Step 6 To verify that the OS image is created, do the following:

a) In Cisco UCS Director, choose Physical > Compute.
b) In the left pane, navigate to the pod that contains the Bare Metal Agent.
c) In the right pane, click PXE Boot Requests.
d) Click Add PXE Boot Request and verify that the OS image is included in the OS Type drop-down list.
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Manually Adding a Linux OS Image in Bare Metal Agent
Procedure

Step 1 Create a directory for the operating system image in the /opt/cnsaroot/images directory of the Bare
Metal Agent VM.
mkdir /opt/cnsaroot/images/image_name

This directory is used to store the operating system image files required for PXE installation.

This directory name is included in the OS Type drop-down list in the Setup PXE Boot task. We
recommend that you make the directory name descriptive enough that you can identify the operating
system of the images within it. For example, we recommend that you name the directory RHEL6.2
or CentOS5.

Note

Step 2 Create a directory for the operating system image with the same name as the one that you created in Step 1
in the /opt/cnsaroot/templates directory of the Bare Metal Agent VM.
mkdir /opt/csnaroot/templates/new_image_name

This directory is used to store the Kickstart and PXE configuration template files for the operating system
image.

Step 3 Copy the .iso file or files for the required operating system to the /tmp directory of the Bare Metal Agent
VM.

Step 4 Mount the .iso file to the iso directory.
mount –o loop /tmp/.iso_file /mnt/iso

Step 5 Copy the entire contents of the .iso file to the /opt/cnsaroot/images/image_name directory that
you created in Step 1.
cp –R /mnt/iso/* /opt/cnsaroot/images/image_name

Make sure that you use the cp –R command to recursively copy the entire contents of the .iso file.
This command copies the underlying directories and their contents also.

Note

Step 6 When the copy operation is complete, unmount the .iso file.
umount /mnt/iso

Step 7 If the operating system image consists of more than one .iso file, repeat Steps 5, 6, and 7 for each .iso
file until the contents of all .iso files have been copied to the /opt/cnsaroot/images/image_name
directory.

Step 8 Create a ks.cfg file and a pxe.cfg file in the /opt/cnsaroot/templates/image_name directory
that you created in Step 2.

touch /opt/cnsaroot/templates/image_name/ks.cfg
touch /opt/cnsaroot/templates/image_name/pxe.cfg

Step 9 Add the required configuration information to the ks.cfg and pxe.cfg files.
For sample ks.cfg and pxe.cfg files andmore information about these files, see Sample Operating System
Configuration Template Files, on page 89.

Step 10 Create a soft link in the /var/www/html directory for this operating system image.
ln –s /opt/cnsaroot/images/image_name /var/www/html/

Cisco UCS Director Bare Metal Agent Installation and Configuration Guide, Release 6.5    
31

Adding Non-Windows OS Images
Manually Adding a Linux OS Image in Bare Metal Agent



Step 11 (Optional) If necessary, update the initrd.img and vmlinuz files for the operating system image as
follows:
a) Copy the initrd.img and vmlinuz files from the /opt/cnsaroot/images/image_name

directory to the /opt/cnsaroot/ directory.
b) Overwrite the current files in this location.

Step 12 In Cisco UCS Director, verify that the operating system image is available from the OS Type drop-down list
in the Setup PXE Boot task.
Wait two minutes, or for whatever duration has been set for the Bare Metal Agent synchronization frequency.
By default, Bare Metal Agent is synchronized with Cisco UCS Director every two minutes. You can change
this frequencywith the bma.sync.frequency property in service.properties.template file under /opt/infra
in the Bare Metal Agent VM.

Manually Adding a VMware vSphere ESXi OS Image in Bare
Metal Agent

Procedure

Step 1 Create a directory for the operating system image data in the /opt/cnsaroot directory of the Bare Metal
Agent VM.
mkdir /opt/cnsaroot/images

This directory is used to store the operating system image files required for PXE installation.

This directory name is included in the OS Type drop-down list in the Setup PXE Boot task. We
recommend that you make the directory name descriptive enough that you can identify the operating
system of the images within it. For example, we recommend that you name the directory
ESXi5.0-update1 or ESXi5.1.

Note

Step 2 Create a directory for the operating system image with the same name as the one that you created in Step 1
in the /opt/cnsaroot/templates directory of the Bare Metal Agent VM.
mkdir /opt/csnaroot/templates/new_image_name

This directory is used to store the Kickstart and PXE configuration template files for the operating system
image.

Step 3 Copy the .iso file or files for the required operating system to the /tmp directory of the Bare Metal Agent
VM.

Step 4 Mount the .iso file to the iso directory.
mount –o loop /tmp/.iso_file /mnt/iso

Step 5 Copy the entire contents of the .iso file to the /opt/cnsaroot/image_name directory that you created
in Step 1.
cp –R /mnt/iso/* /opt/cnsaroot/image_name

Make sure that you use the cp –R command to recursively copy the entire contents of the .iso file.
This command copies the underlying directories and their contents also.

Note
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Step 6 When the copy operation is complete, unmount the .iso file.
umount /mnt/iso

Step 7 If the operating system image consists of more than one .iso file, repeat Steps 5, 6, and 7 for each .iso
file until the contents of all .iso files have been copied to the /opt/cnsaroot/image_name directory.

Step 8 Create a ks.cfg file and a pxe.cfg file in the /opt/cnsaroot/templates/image_name directory
that you created in Step 2.

touch /opt/cnsaroot/templates/image_name/ks.cfg
touch /opt/cnsaroot/templates/image_name/pxe.cfg

Step 9 Add the required configuration information to the ks.cfg and pxe.cfg files.
For sample ks.cfg and pxe.cfg files andmore information about these files, see Sample Operating System
Configuration Template Files, on page 89.

Step 10 Copy the boot.cfg file from the /opt/cnsaroot/image_name directory to the
/opt/cnsaroot/templates/image_name directory.

cd /opt/cnsaroot/templates/image_name/
cp /opt/cnsaroot/image_name/boot.cfg ./

Step 11 Edit the boot.cfg file in the /opt/cnsaroot/templates/image_name directory as follows:
a) After the title= line, add a prefix=/image_name/ line.
b) Append pxebooting ks=$PXE_KS_URL to the end of the kernelopt=runweasel line.
c) Remove the leading / from all modules listed in the boot.cfg file.
d) Save the edited file.

Step 12 In Cisco UCS Director, verify that the operating system image is available from the OS Type drop-down list
in the Setup PXE Boot task.
Wait two minutes, or for whatever duration has been set for the Bare Metal Agent synchronization frequency.
By default, Bare Metal Agent is synchronized with Cisco UCS Director every two minutes. You can change
this frequencywith the bma.sync.frequency property in service.properties.template file under /opt/infra
in the Bare Metal Agent VM.

Cisco UCS Director Bare Metal Agent Installation and Configuration Guide, Release 6.5    
33

Adding Non-Windows OS Images
Manually Adding a VMware vSphere ESXi OS Image in Bare Metal Agent



   Cisco UCS Director Bare Metal Agent Installation and Configuration Guide, Release 6.5
34

Adding Non-Windows OS Images
Manually Adding a VMware vSphere ESXi OS Image in Bare Metal Agent



C H A P T E R  7
Adding Windows OS Images

This chapter contains the following sections:

• Windows Operating Systems Supported for Cisco UCS Director Bare Metal Agent, page 35

• Guidelines and Limitations for Windows Operating System Images, page 36

• Windows Server 2008 R2 x64 Operating System Images, page 36

• Windows Server 2012 x64 and 2012 R2 x64 Operating System Images, page 46

• Windows Server 2016 x64 Operating System Images, page 54

• Using MEMDISK for Deploying Multiple Versions of Windows Simultaneously, page 59

Windows Operating Systems Supported for Cisco UCS Director
Bare Metal Agent

Cisco UCS Director Bare Metal Agent (Bare Metal Agent) supports the followingWindows operating system
(OS) images and the automated creation of their required answer files:

•Windows Server 2008 R2 x64

•Windows Server 2012 x64

•Windows Server 2012 R2 x64

•Windows Server 2016 x64

You can set up all four OS images in Bare Metal Agent. You can use the same answer file for both local boot
and SAN boot.

The procedure for setting up a Windows OS image depend upon the operating system. Make sure you use the
appropriate procedure for the OS image that you are setting up.
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After adding Bare Metal Agent to Cisco UCS Director and running inventory, Cisco UCS Director shows
as if Windows images are added by default. But no Windows images are added. Install Windows images
manually.

Note

Guidelines and Limitations for Windows Operating System
Images

Consider the following guidelines and limitations when you set upWindows Server OS images for provisioning:

Follow a Strict Naming Convention

You must follow a strict naming convention when you configure the files for Windows OS images. The paths
and file names are case sensitive.

Mistakes in naming will require you to modify the names throughout the Bare Metal Agent data
infrastructure.

Note

Ensure That File Names, Drive Letters, and Other Information Match in All Files

If you use the automatically generated answer file, Bare Metal Agent ensures that the file names, drive letters
and other information match.

However, if you manually edit the answer file, you must ensure that the drive letter in the WinPE.wim
matches the drive letter provided in the answer file. With this configuration you are defining WinPE.wim
such that it installs Windows from a particular location by using an answer file setup option. The static names,
paths, IP addresses, drive letters, answer file name, and user name credentials must be correct.

File and folder names are case sensitive: WinPE.wim names must exactly match entries in the Boot
Configuration Data (BCD) store.

Use Single Path Workflow for SAN Boot

Because the Windows installation does not support multi-path SAN boot, you must use the single path
workflow to achieve SAN boot.

Warning

Windows Server 2008 R2 x64 Operating System Images
The Windows Server 2008 R2 x64 OS (Windows 2008 OS) supports PXE boot and installation operations.
You can use this OS image in bare metal provisioning workflows.

   Cisco UCS Director Bare Metal Agent Installation and Configuration Guide, Release 6.5
36

Adding Windows OS Images
Guidelines and Limitations for Windows Operating System Images



Prerequisites for Setting Up Windows Server 2008 R2 x64 Operating System
Images

To install and set up the environment and files that are required for the setup of Windows Server 2008 R2
x64 OS images, you must first download the following:

•Windows Assessment and Deployment Kit (ADK, sometimes called as Windows ADK). See
https://www.microsoft.com/en-us/download/details.aspx?id=30652. The Windows ADK enables you
to generate a customized WinPE. Make sure Windows ADK is compatible with Windows Server 2008
R2 version.

•Windows Server 2008 R2 x64 ISO version.

You need not manually create a Windows answer file when setting up the Windows OS images. Bare
Metal Agent builds the Windows answer file necessary to support your PXE Boot request, based on the
information you provide when you create the PXE boot request.

Note

Before installing theWindows 2008 R2 operating system using the BareMetal Agent VM, set up and configure
the following prerequisites:

• A customized Windows Pre-installation Environment (WinPE)

• Boot Configuration Data (BCD) file (optional)

•Windows installation files (the files extracted from the ISO image file)

We recommend that you use the Windows 2008 R2 OS ISO image file, which contains all editions,
including Standard, Enterprise, Datacenter, and Web. You can typically remove all editions except for
Standard and Datacenter.

Tip

After customizing the WinPE image and creating the BCD file, you must do the following:

• Set up WinPE and copy the supporting files to the Bare Metal Agent VM for the PXE boot.

• Extract the Windows 2008 R2 OS ISO image files into the appropriate image repository directory.

Creating a Customized WinPE
You need to create and customize the Windows Preinstallation Environment (WinPE) for Windows 2008 R2
x64. The initial WinPE includes the minimum boot image necessary to load kernel and default device drivers
supported by the Windows OS. Most servers require additional drivers, such as network interface cards and
storage controllers that enable Windows OS to detect the network and disks during installation. You must
add these drivers to the WinPE.wim image.

Add the device drivers to the WinPE image by using the Deployment Image Servicing and Management
(DISM.exe) command tool, which is installed with the Windows ADK. Make sure that you download the
required device drivers before you execute the associated DISM commands.

Cisco UCS Director Bare Metal Agent Installation and Configuration Guide, Release 6.5    
37

Adding Windows OS Images
Prerequisites for Setting Up Windows Server 2008 R2 x64 Operating System Images

https://www.microsoft.com/en-us/download/details.aspx?id=30652


The following procedure includes a sample configuration that is for reference only. The sample configuration
might or might not work in your environment. For information about adding device drivers to the WinPE
image through DISM.exe, see the documentation provided by Microsoft.

Important

Before You Begin

Complete the prerequisites listed in Prerequisites for Setting Up Windows Server 2008 R2 x64 Operating
System Images, on page 37.

Download the following:

•Windows Assessment and Deployment Kit (Windows ADK) specifically for Windows 2008 R2 x64.

• Required device drivers to be added to the WinPE.wim image.

Procedure

Step 1 Launch the command prompt (click Start > All Programs > Accessories > Command Prompt).
Step 2 Change the directory to Windows ADK installation directory.

cd C:\Program Files (x86)\Windows Kits\8.0\Assessment and Deployment Kit\Windows
Preinstallation Environment

Here, C:\Program Files (x86)\Windows Kits\8.0\Assessment and Deployment
Kit\Windows Preinstallation Environment is the directory where Windows ADK has been
installed.

Step 3 Create a new WinPE environment folder using ‘copype.cmd’ command.
copype.cmd amd64 c:\win2k8r2x64

Here, c:\win2k8r2x64 is the directory where the new WinPE environment is created.
Step 4 Extract the device drivers to a folder. For example, c:\cisco\drivers.
Step 5 Add the device drivers to the WinPE image by using the DISM.exe command.

• Mount the WinPE.wim image:
DISM.exe /mount-wim /wimfile:c:\win2k8r2x64\WinPE.wim /index:1
mountdir:c:\win2k8r2x64\mount

• Add the device drivers to WinPE.wim image by using the individual driver’s absolute path:
DISM.exe /image:c:\win2k8r2x64\mount /Add-Driver /driver:C:\cisco\drivers\1.inf
/driver:C:\cisco\drivers\2.inf /driver:C:\cisco\drivers\3.inf

• Alternatively, add the device drivers to the WinPE.wim image by automatically searching through all
the subfolders of the device drivers directory:
DISM.exe /image:c:\win2k8r2x64\mount /Add-Driver /driver:C:\cisco\drivers /Recurse

Step 6 Unmount the WinPE.wim image and commit the changes:
DISM.exe /unmount-wim /mountdir:c:\win2k8r2x64\mount /commit

When all the device drivers have been added, the WinPE.wim image is ready to be used.
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Preparing Windows Server 2008 R2 Installation Files

Before You Begin

You must have the following in place:

•WindowsAssessment andDeployment Kit (ADK, sometimes called asWindowsADK) that is compatible
with the Windows 2008 R2 operating system

•Windows 2008 R2 ISO image

Procedure

Step 1 Launch the command prompt (click Start > All Programs > Accessories > Command Prompt).
Step 2 Create a new folder and extract the Windows 2008 R2 ISO image installation files to the folder.

mkdir c:\win2k8r2x64-iso

Step 3 Take a backup copy of the install.wim file.
cd c:\win2k8r2x64-iso\sources
copy install.wim install.wim.backup

The backup is recommended as device drivers will be added to the install.wim file in the subsequent steps.
The device drivers are used during the installation of the Windows 2008 R2 operating system.

Step 4 Create a folder to mount the c:\win2k8r2x64-iso\sources\install.wim file.
mkdir c:\win2k8r2x64-mount

Step 5 Change the directory to the Windows ADK installation directory.
cd C:\Program Files (x86)\Windows Kits\8.0\Assessment and Deployment Kit\Deployment
Tools\amd64\DISM

Step 6 Add the device drivers to the install.wim image by using the DISM.exe command from the Windows ADK
installation directory.

Step 7 List the supported Windows 2008 R2 Editions.
dism.exe /Get-ImageInfo /imagefile:c:\win2k8r2x64-iso\sources\install.wim

The supported Windows 2008 R2 editions are listed, with each edition represented by an Index ID. Choose
the corresponding Index ID of the Windows 2008 R2 Edition that you want to install through PXE.

Index : 1
Name : Windows Server 2008 R2 SERVERSTANDARD
Description : Windows Server 2008 R2 SERVERSTANDARD
Size : 10,510,509,480 bytes

Index : 2
Name : Windows Server 2008 R2 SERVERSTANDARDCORE
Description : Windows Server 2008 R2 SERVERSTANDARDCORE
Size : 3,563,998,339 bytes

Index : 3
Name : Windows Server 2008 R2 SERVERENTERPRISE
Description : Windows Server 2008 R2 SERVERENTERPRISE
Size : 10,510,890,698 bytes

Index : 4
Name : Windows Server 2008 R2 SERVERENTERPRISECORE
Description : Windows Server 2008 R2 SERVERENTERPRISECORE
Size : 3,563,972,455 bytes
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Index : 5
Name : Windows Server 2008 R2 SERVERDATACENTER
Description : Windows Server 2008 R2 SERVERDATACENTER
Size : 10,510,997,874 bytes

Index : 6
Name : Windows Server 2008 R2 SERVERDATACENTERCORE
Description : Windows Server 2008 R2 SERVERDATACENTERCORE
Size : 3,564,010,572 bytes

Index : 7
Name : Windows Server 2008 R2 SERVERWEB
Description : Windows Server 2008 R2 SERVERWEB
Size : 10,520,088,768 bytes

Index : 8
Name : Windows Server 2008 R2 SERVERWEBCORE
Description : Windows Server 2008 R2 SERVERWEBCORE
Size : 3,562,616,654 bytes

Step 8 Mount the install.wim image with Index ID 5 to install Windows 2008 R2 Datacenter Edition.
DISM.exe /mount-wim /wimfile:c:\win2k8r2x64-iso\sources\install.wim /index:5
mountdir:c:\win2k8r2x64-mount

Step 9 Add device drivers to the install.wim image by using the individual driver's absolute path.
DISM.exe /image:c:\win2k8r2x64-mount /Add-Driver /driver:C:\cisco\drivers\1.inf
/driver:C:\cisco\drivers\2.inf /driver:C:\cisco\drivers\3.inf

Alternatively, you can add the device drivers to the install.wim image by automatically searching through all
the subfolders of the device drivers directory.
DISM.exe /image:c:\win2k8r2x64-mount /Add-Driver /driver:C:\cisco\drivers /Recurse

Step 10 Unmount the install.wim image and commit the changes.
DISM.exe /unmount-wim /mountdir:c:\win2k8r2x64-mount /commit

When all the device drivers have been added, the install.wim image is ready to be
used.

Note

Creating a Boot Configuration Data File
The Boot Configuration Data (BCD) file contains the boot configuration parameters. It controls how the
operating system is started inWindows and is used to load the base kernel (WinPE.wim) from the PXE server.
Creating a new BCD file is optional. The Bare Metal Agent provides a BCD file with default configuration
out of the box. The absolute location path of the BCD file is /opt/cnsaroot/Boot/BCD. The default
BCD file can be used to install any Windows OS version, unless it is required to be customized for a specific
version of Windows.

By default, the BCD file points to /opt/cnsaroot/Boot/WinPE.wim and
/opt/cnsaroot/Boot/boot.sdi files. These filenames are case sensitive.

The new BCD file can be created through the BCDEdit command-line tool. This tool is commonly available
in the Windows operating system under root directory, C:\Windows\system32.
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Procedure

Step 1 Launch the command prompt (click Start > All Programs > Accessories > Command Prompt).
Step 2 Create a new working directory to create a new BCD file. (At the command prompt, type C:\> mkdir

C:\NewBCDStore)
Step 3 Change the directory toC:\NewBCDStore. (At the command prompt, typeC:\> cd C:\NewBCDStore)
Step 4 Run the below sequence of commands to create a new BCD file:

C:\NewBCDStore> C:\Windows\System32\bcdedit.exe /createstore BCD

C:\NewBCDStore> C:\Windows\System32\bcdedit.exe /store BCD /create {ramdiskoptions} /d
"Ramdisk options"

C:\NewBCDStore> C:\Windows\System32\bcdedit.exe /store BCD /set {ramdiskoptions}
ramdisksdidevice boot

C:\NewBCDStore> C:\Windows\System32\bcdedit.exe /store BCD /set {ramdiskoptions}
ramdisksdipath \Boot\boot.sdi

C:\NewBCDStore> C:\Windows\System32\bcdedit.exe /store BCD /create /d "My WinPE Boot Image"
/application osloader

Running the above command generates and displays a new GUID as the command output.
Step 5 Run the following commands. When you run these commands, replace the GUID (for example:

{a20f8db8-7459-11e2-8ec3-00155d37efa7}) with the GUID generated from your system:

C:\NewBCDStore> C:\Windows\System32\bcdedit.exe /store BCD /set
{a20f8db8-7459-11e2-8ec3-00155d37efa7} systemroot \Windows

C:\NewBCDStore> C:\Windows\System32\bcdedit.exe /store BCD /set
{a20f8db8-7459-11e2-8ec3-00155d37efa7} detecthal Yes

C:\NewBCDStore> C:\Windows\System32\bcdedit.exe /store BCD /set
{a20f8db8-7459-11e2-8ec3-00155d37efa7} winpe Yes

C:\NewBCDStore> C:\Windows\System32\bcdedit.exe /store BCD /set
{a20f8db8-7459-11e2-8ec3-00155d37efa7} osdevice ramdisk=[boot]\Boot\WinPE.wim,{ramdiskoptions}

C:\NewBCDStore> C:\Windows\System32\bcdedit.exe /store BCD /set
{a20f8db8-7459-11e2-8ec3-00155d37efa7} device ramdisk=[boot]\Boot\WinPE.wim,{ramdiskoptions}

C:\NewBCDStore> C:\Windows\System32\bcdedit.exe /store BCD /create {bootmgr} /d "Windows
2008r2 BootManager"

C:\NewBCDStore> C:\Windows\System32\bcdedit.exe /store BCD /set {bootmgr} timeout 30

C:\NewBCDStore> C:\Windows\System32\bcdedit.exe /store BCD /displayorder
{a20f8db8-7459-11e2-8ec3-00155d37efa7}

Use the following command to verify that the configurations are correct:
C:\NewBCDStore> C:\Windows\System32\bcdedit.exe /store BCD /enum all
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What to Do Next

Verify that you have appropriate Windows 2008 R2 OS installation files inside the ISO image.

Verifying the Installation files For All Editions of Windows 2008 R2

Before You Begin

Mount or extract the Windows 2008 R2 ISO image.

Procedure

Verify that you have the following CLG files under the SOURCE folder of mounted or extracted Windows
2008 R2 ISO image:

• install_Windows Server 2008 R2 SERVERDATACENTER.clg

• install_Windows Server 2008 R2 SERVERDATACENTERCORE.clg

• install_Windows Server 2008 R2 SERVERENTERPRISE.clg

• install_Windows Server 2008 R2 SERVERENTERPRISECORE.clg

• install_Windows Server 2008 R2 SERVERSTANDARD.clg

• install_Windows Server 2008 R2 SERVERSTANDARDCORE.clg

• install_Windows Server 2008 R2 SERVERDATAWEB.clg

• install_Windows Server 2008 R2 SERVERDATAWEBCORE.clg

What to Do Next

Edit theWinPE.wim image file to add PowerShell packages and modify the startnet.cmd file with PXE install
commands and parameters as described in Customizing and Copying the WinPE.wim and PXE Boot Files
for Windows 2008 R2, on page 42.

Customizing and Copying the WinPE.wim and PXE Boot Files for Windows
2008 R2

Procedure

Step 1 Launch the command prompt (click Start > All Programs > Accessories > Command Prompt).
Step 2 Change the directory to WinPE environment that was created.

cd c:\win2k8r2x64

Step 3 Mount WinPE.wim image to a folder called 'mount' under the c:\win2k8r2x64 directory.
DISM.exe /mount-wim /wimfile:c:\win2k8r2x64\WinPE.wim /index:1 /mountdir:c:\win2k8r2x64\mount
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Step 4 In WinPE.wim, add the required PowerShell packages and edit the paths in each command with the correct
mount point and ADK installation path for your environment.

The Powershell package files shown below are provided for your reference only. The PowerShell
packages and file names that you need to add to WinPE.wim are dependent upon the version of
Windows and WinPE.wim.To determine which PowerShell packages you need to add, see the
compliance report on theMicrosoft website. For information about the commands to add the necessary
packages for PowerShell, see the WinPE: Adding PowerShell support to Windows PE Technet Page.

Note

Dism /Add-Package /Image:"C:\win2k8r2x64\mount" /PackagePath:"C:\Program Files (x86)\Windows
Kits\8.0\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\WinPE-WMI.cab"

Dism /Add-Package /Image:"C:\win2k8r2x64\mount" /PackagePath:"C:\Program Files (x86)\Windows
Kits\8.0\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\en-us\WinPE-WMI_en-us.cab"

Dism /Add-Package /Image:"C:\win2k8r2x64\mount" /PackagePath:"C:\Program Files (x86)\Windows
Kits\8.0\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\WinPE-NetFX.cab"

Dism /Add-Package /Image:"C:\win2k8r2x64\mount" /PackagePath:"C:\Program Files (x86)\Windows
Kits\8.0\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\en-us\WinPE-NetFX_en-us.cab"

Dism /Add-Package /Image:"C:\win2k8r2x64\mount" /PackagePath:"C:\Program Files (x86)\Windows
Kits\8.0\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\WinPE-Scripting.cab"

Dism /Add-Package /Image:"C:\win2k8r2x64\mount" /PackagePath:"C:\Program Files (x86)\Windows
Kits\8.0\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\en-us\WinPE-Scripting_en-us.cab"

Dism /Add-Package /Image:"C:\win2k8r2x64\mount" /PackagePath:"C:\Program Files (x86)\Windows
Kits\8.0\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\WinPE-PowerShell.cab"

Dism /Add-Package /Image:"C:\win2k8r2x64\mount" /PackagePath:"C:\Program Files (x86)\Windows
Kits\8.0\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\en-us\WinPE-PowerShell_en-us.cab"

Dism /Add-Package /Image:"C:\win2k8r2x64\mount" /PackagePath:"C:\Program Files (x86)\Windows
Kits\8.0\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\WinPE-StorageWMI.cab"

Dism /Add-Package /Image:"C:\win2k8r2x64\mount" /PackagePath:"C:\Program Files (x86)\Windows
Kits\8.0\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\en-us\WinPE-StorageWMI_en-us.cab"

Dism /Add-Package /Image:"C:\win2k8r2x64\mount" /PackagePath:"C:\Program Files (x86)\Windows
Kits\8.0\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\WinPE-DismCmdlets.cab"

Dism /Add-Package /Image:"C:\win2k8r2x64\mount" /PackagePath:"C:\Program Files (x86)\Windows
Kits\8.0\Assessment and Deployment Kit\Windows Preinstallation
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Environment\amd64\WinPE_OCs\en-us\WinPE-DismCmdlets_en-us.cab"

Step 5 Navigate to the mount folder (c:\win2k8r2x64\mount in the code example above) and verify that you
can see the data inside the mount folder.

Step 6 Navigate to \windows\system32 in the mount folder and do the following:
a) Edit startnet.cmd.
b) Paste the following entries into the file in the order shown, to update the IP address and other details as

required for your environment:

wpeinit
wpeutil.exe InitializeNetwork
wpeutil.exe disablefirewall
ECHO OFF
net use R: \\Baremetal_Agent_PXE_IP_Address\bits /user:user_id password
ECHO ON
R:
Powershell.exe -NonInteractive -NoLogo -ExecutionPolicy bypass -command R:\enroute.ps1

Note • Use the drvload command when a driver has failed to be installed. For example, include the
following line in the startnet.cmd file to install a fnic driver:

drvload <ipaddress of share>:\\<the_fnic.inf>

Use the drvload command only when you face issues in installing drivers. Otherwise, follow
the standard process to inject a driver to WinPE.

• Make sure that you modify the IP address in all the entries so that they point to the Bare Metal
Agent IP address.

• All drive letter references (such as the reference to an R: drive) must match in both the
startnet.cmd file and the Windows answer file. By default, Bare Metal Agent comes with
an R: drive letter assignment.

Step 7 Save the startnet.cmd file.
Step 8 After you have confirmed that the startnet.cmd is updated correctly, unmount WinPE.wim with the

DISM Unmount command and use the /commit option to save the modified startnet.cmd file.

DISM.exe /Unmount-Wim /Mountdir:c:\win2k8r2x64\mount /commit

Do not leave any files open that are located in the mounted directory when you unmount
WinPE.wim. If you have any files open, the unmount process might fail.

Caution

What to Do Next

Copy the customized Windows installation files to the Bare Metal Agent VM.
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Copying the Customized Windows Installation Files to the Bare Metal Agent
VM

Before You Begin

You must have the following in place:

• Customized WinPE.wim image file

• Customized install.wim image file

• Customized BCD file (optional)

•Windows 2008 R2 ISO image

Procedure

Step 1 Copy the following files into the Bare Metal Agent VM. You can use either WinSCP or an equivalent tool to
copy the files.

• CustomizedWinPE.wim image file from c:\win2k8r2x64 to the /opt/cnsaroot/Boot folder.

• Customized BCD file from c:\NewBCDStore to the /opt/cnsaroot/Boot folder (optional).

• Customized install.wim image file from c:\win2k8r2x64-iso\sources to /tmp folder.

•Windows 2008 R2 ISO image file into the /tmp folder.

Step 2 Log on to the Bare Metal Agent VM using SSH client as 'root' user.
Step 3 Change the folder to /tmp.
Step 4 Mount the Windows 2008 R2 ISO image to the /mnt folder.

mount -o loop /tmp/(Windows-2008R2-ISO-Filename) /mnt

Step 5 Copy the Windows 2008 R2 install files to /samba/Win2k8R2x64 folder.
cd /samba/Win2k8R2x64
cp -r /mnt/*

Step 6 Verify that all the Windows 2008 R2 installation files are copied.
Step 7 Move the install.wim image file from /tmp to /samba/Win2k8R2x64/sources folder.

mv /tmp/install.wim /samba/Win2k8R2x64/sources/

Step 8 Unmount the Windows 2008 R2 ISO image from the /mnt folder.
umount /mnt

Step 9 Open the /samba/notifications/notify.ps1 file and verify that the IP address in the file matches
that of the PXE IP address of Bare Metal Agent.
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Windows Server 2012 x64 and 2012 R2 x64 Operating System
Images

Cisco UCS Director Bare Metal Agent supports PXE boot and installation operations for Windows 2012 x64
or 2012 R2 x64 OS images and PXE boot tasks used in bare metal provisioning workflows.

If you need to support bothWindows 2012 and 2012 R2, you must perform the image setup process twice,
once for each OS. Although it is possible to set up a single WinPE file that supports multiple Windows
OS versions, we recommend that you set up a separate WinPE file for each OS.

Note

Prerequisites for Setting Up Windows Server 2012 x64 and 2012 R2 x64
Operating System Images

Before you can install a Windows 2012 or 2012 R2 OS image in the /opt/cnsaroot/Boot directory of
the Bare Metal Agent VM, you must install and set up the following prerequisites:

•WindowsAssessment andDeployment Kit (WindowsADK, version 8.0 or later recommended, depending
on the Windows version compatibilities with respect to the WinPE.wim file)

• A customized Windows Preinstallation Environment (WinPE.wim) and PXE supporting files

• Boot Configuration Data (BCD) file

•Windows installation files (the files extracted from the ISO)

You do not need to manually create a Windows answer file when setting up Windows OS images. Bare
Metal Agent builds the Windows answer file necessary to support your PXE Boot request, based on the
information you provide when you create the PXE boot request.

Note

To install and set up the images, download the following:

•Windows Assessment and Deployment Kit that supports Windows Server 2012 and Windows Server
2012 R2. For more information, see http://technet.microsoft.com/en-us/library/dn613859.aspx.

•Windows Server 2012 x64 and/or 2012 R2 x64 (Standard and Datacenter editions are required).

We recommend that you use the ISO download file, which contains all editions, including Standard,
Enterprise, Datacenter, andWeb. You can typically remove all editions except for Standard and Datacenter.

Tip

After the system image is in place, perform the following additional procedures:

• Set up WinPE and copy the supporting files to the Network Service Agent server for the PXE boot.

• Copy the Windows installation files to the server path.
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Creating a Custom WinPE and Copying the PXE Supported Files for Windows
2012

The /opt/cnsaroot/Boot folder is static, and each Bare Metal Agent can have only one boot folder.Note

Before You Begin

Complete the prerequisites listed in Prerequisites for Setting Up Windows Server 2012 x64 and 2012 R2 x64
Operating System Images, on page 46.

Procedure

Step 1 Download an ADK version that supports Windows 2012 and install it on a Windows 2012 machine.
When you specify the features to include in the download, you must include the Windows PE and
Deployment Tools.

Note

Step 2 Navigate to the Windows Pre-installation Environment folder in the ADK tools and execute copype.cmd to
create the files that WinPE requires.

Copype.cmd amd64 C:\WinPE_amd64

The target directory contains the WinPE.wim file. The latest ADK versions create a boot.vim file, which
needs to be renamed to WinPE.wim.

Step 3 In theWindows machine that has the ADK tools installed, create a directory. Copy the WinPE.wim file from
/opt/cnsaroot/Boot to the directory you have created.

Step 4 At the command line, navigate to the ADK installed folder.
Step 5 Add the drivers from their folder locations to the WinPE image.

Use the following DISM.exe command when you know the paths to the drivers that you want to add.

// The DISM.exe command mounts the WinPE to a folder.
// In this example, the c:\win2k12x64 directory and the \mount subdirectory have been created
before running the command.
DISM.exe /mount-wim /wimfile:c:\win2k12x64\WinPE.wim /index:1 /mountdir:c:\win2k12x64\mount

// To add individual driver files to WinPE image, use the following format.
DISM.exe /image:c:\win2k12x64\mount /Add-Driver /driver:C:\test\drivers\1.inf
/driver:C:\test\drivers\2.inf /driver:C:\test\drivers\3.inf

Use the following DISM.exe command when you do not know the paths to the drivers that you want to add
and need to query all subfolders.

// The DISM.exe command mounts the WinPE to a folder.
// In this example, the c:\win2k12x64 directory and the \mount subdirectory have been created
before running the command.
DISM.exe /mount-wim /wimfile:c:\win2k12x64\WinPE.wim /index:1 /mountdir:c:\win2k12x64\mount
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// To add individual driver files to WinPE image, use the following format.
DISM.exe /image:c:\win2k12x64\mount /Add-Driver /driver:c:\test\drivers /Recurse

Step 6 Mount WinPE.wim to a folder.
Step 7 In WinPE.wim, add the required PowerShell packages and edit the paths in each command with the correct

mount point and ADK installation path for your environment.
The PowerShell packages and file names that you need to add to WinPE.wim are dependent upon
the version of Windows and WinPE.wim.To determine which PowerShell packages you need to
add, see the compliance report on the Microsoft website. For information about the commands to
add the necessary packages for PowerShell, see theWinPE: Adding PowerShell support to Windows
PE Technet Page. The PowerShell package files shown below are provided for reference and will
vary depending on the version of Windows and WinPE.wim.

Note

\\ Sample PowerShell package files.
\\ The PowerShell packages and file names that you need to add to WinPE.wim vary depending
on the version of Windows and WinPE.wim.

Dism /Add-Package /Image:"C:\win2k12x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\8.1\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\WinPE-WMI.cab"

Dism /Add-Package /Image:"C:\win2k12x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\8.1\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\en-us\WinPE-WMI_en-us.cab"

Dism /Add-Package /Image:"C:\win2k12x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\8.1\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\WinPE-NetFX.cab"

Dism /Add-Package /Image:"C:\win2k12x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\8.1\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\en-us\WinPE-NetFX_en-us.cab"

Dism /Add-Package /Image:"C:\win2k12x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\8.1\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\WinPE-Scripting.cab"

Dism /Add-Package /Image:"C:\win2k12x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\8.1\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\en-us\WinPE-Scripting_en-us.cab"

Dism /Add-Package /Image:"C:\win2k12x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\8.1\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\WinPE-PowerShell.cab"

Dism /Add-Package /Image:"C:\win2k12x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\8.1\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\en-us\WinPE-PowerShell_en-us.cab"

Dism /Add-Package /Image:"C:\win2k12x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\8.1\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\WinPE-StorageWMI.cab"
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Dism /Add-Package /Image:"C:\win2k12x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\8.1\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\en-us\WinPE-StorageWMI_en-us.cab"

Dism /Add-Package /Image:"C:\win2k12x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\8.1\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\WinPE-DismCmdlets.cab"

Dism /Add-Package /Image:"C:\win2k12x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\8.1\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\en-us\WinPE-DismCmdlets_en-us.cab"

Step 8 Navigate to \windows\system32 in the mount folder. In the startnet.cmd, update the IP address for
Bare Metal Agent.
Note • Do not change any information in the startnet.cmd file, except for the Bare Metal Agent

IP address.

• Make sure that you modify the IP addresses in all the entries so that they point to the BareMetal
Agent IP address.

• All drive letter references (such as the reference to an R: drive) must match in both the
startnet.cmd file and the Windows answer file. By default, Bare Metal Agent comes with
an R: drive letter assignment.

Step 9 Unmount the WinPE, commit the changes, and copy the file to the /opt/cnsaroot/Boot directory in
the Bare Metal Agent VM.
DISM.exe /Unmount-Wim /Mountdir:c:\win2k12x64\mount /commit

What to Do Next

Install and set up (as necessary) the Boot Configuration Data (BCD) file.

Creating a Custom WinPE and Copying the PXE Supported Files for Windows
2012 R2

For Windows Server 2012 R2 x64, Bare Metal Agent provides the WinPE and supported PXE files. You need
only add any required drivers to the WinPE.wim file, and then edit the WinPE.wim file to change the IP
address in the startnet.cmd file to the PXE IP address for your Bare Metal Agent.

The /opt/cnsaroot/Boot folder is static, and each Bare Metal Agent can have only one boot folder.Note

Before You Begin

Complete the prerequisites listed in Prerequisites for Setting Up Windows Server 2012 x64 and 2012 R2 x64
Operating System Images, on page 46.
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Procedure

Step 1 Download an ADK version that supports Windows 2012 R2 and install it on a Windows 2012 R2 machine.
When you specify the features to include in the download, you must include the Windows PE and
Deployment Tools.

Note

Step 2 In theWindows machine that has the ADK tools installed, create a directory. Copy the WinPE.wim file from
/opt/cnsaroot/Boot to the directory you created.

Step 3 At the command line, navigate to the ADK installed folder.
Step 4 Add the drivers from their folder locations to the WinPE image.

Use the following DISM.exe command when you know the paths to the drivers that you want to add.

// The DISM.exe command mounts the WinPE to a folder.
// In this example, the c:\win2k12r2x64 directory and the \mount subdirectory have been
created before running the command.
DISM.exe /mount-wim /wimfile:c:\win2k12r2x64\WinPE.wim /index:1
/mountdir:c:\win2k12r2x64\mount

// To add individual driver files to WinPE image, use the following format.
DISM.exe /image:c:\win2k12r2x64\mount /Add-Driver /driver:C:\test\drivers\1.inf
/driver:C:\test\drivers\2.inf /driver:C:\test\drivers\3.inf

Use the following DISM.exe command when you do not know the paths to the drivers that you want to add
and need to query all subfolders.

// The DISM.exe command mounts the WinPE to a folder.
// In this example, the c:\win2k12r2x64 directory and the \mount subdirectory have been
created before running the command.
DISM.exe /mount-wim /wimfile:c:\win2k12r2x64\WinPE.wim /index:1
/mountdir:c:\win2k12r2x64\mount

// To add individual driver files to WinPE image, use the following format.
DISM.exe /image:c:\win2k12r2x64\mount /Add-Driver /driver:c:\test\drivers /Recurse

Step 5 Mount winPE.wim to a folder.
Step 6 In WinPE.wim, add the required PowerShell packages and edit the paths in each command with the correct

mount point and ADK installation path for your environment.
The PowerShell packages and file names that you need to add to WinPE.wim are dependent on the
version of Windows and WinPE.wim. To determine which PowerShell packages you need to add,
see the compliance report on the Microsoft website. For information about the commands to add the
necessary packages for PowerShell, see the WinPE: Adding PowerShell support to Windows PE
Technet Page. The PowerShell package files shown below are provided for reference and will vary
depending on the version of Windows and WinPE.wim.

Note

\\ Sample PowerShell package files.
\\ The PowerShell packages and file names that you need to add to WinPE.wim vary depending
on the version of Windows and WinPE.wim.

Dism /Add-Package /Image:"C:\win2k12r2x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\8.1\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\WinPE-WMI.cab"
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Dism /Add-Package /Image:"C:\win2k12r2x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\8.1\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\en-us\WinPE-WMI_en-us.cab"

Dism /Add-Package /Image:"C:\win2k12r2x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\8.1\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\WinPE-NetFX.cab"

Dism /Add-Package /Image:"C:\win2k12r2x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\8.1\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\en-us\WinPE-NetFX_en-us.cab"

Dism /Add-Package /Image:"C:\win2k12r2x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\8.1\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\WinPE-Scripting.cab"

Dism /Add-Package /Image:"C:\win2k12r2x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\8.1\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\en-us\WinPE-Scripting_en-us.cab"

Dism /Add-Package /Image:"C:\win2k12r2x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\8.1\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\WinPE-PowerShell.cab"

Dism /Add-Package /Image:"C:\win2k12r2x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\8.1\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\en-us\WinPE-PowerShell_en-us.cab"

Dism /Add-Package /Image:"C:\win2k12r2x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\8.1\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\WinPE-StorageWMI.cab"

Dism /Add-Package /Image:"C:\win2k12r2x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\8.1\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\en-us\WinPE-StorageWMI_en-us.cab"

Dism /Add-Package /Image:"C:\win2k12r2x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\8.1\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\WinPE-DismCmdlets.cab"

Dism /Add-Package /Image:"C:\win2k12r2x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\8.1\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\en-us\WinPE-DismCmdlets_en-us.cab"

Step 7 Navigate to \windows\system32 in the mount folder. In the startnet.cmd, update the IP address for
Bare Metal Agent.
Note • Do not change any information in the startnet.cmd file, except the IP address for Bare

Metal Agent.

• Make sure that you modify the IP address in all the entries so that they point to the Bare Metal
Agent IP address.

• All drive letter references (such as the reference to an R: drive) must match in both the
startnet.cmd file and the Windows answer file. By default, Bare Metal Agent comes with
an R: drive letter assignment.
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Step 8 Unmount the WinPE, commit the changes, and copy the file to the /opt/cnsaroot/Boot directory in
the Bare Metal Agent VM.
DISM.exe /Unmount-Wim /Mountdir:c:\win2k12r2x64\mount /commit

What to Do Next

Install and set up (as necessary) the Boot Configuration Data (BCD) file.

Installing and Setting Up the Boot Configuration Data File
The Boot Configuration Data (BCD) file contains the boot configuration parameters. It controls how the
operating system is started inWindows and is used to load the base kernel (WinPE.wim) from the PXE server.
You do not need to create a BCD file. Bare Metal Agent provides a BCD file with default paths that you can
use.

By default, the BCD file points to the /Boot/WinPE.wim and boot.sdi files. These filenames are case
sensitive.

We recommend that you use a set of standard names for Bare Metal Agent configuration purposes. The
folder name should be Boot. The winpe file name should be WinPE.wim. Use corresponding filenames
such as boot.sdi. The created BCD file should be in uppercase, and this file will not have any file extension.
Bare Metal Agent delivers the BCD file to /opt/cnsaroot/Boot, which contains a default path
pointing to /opt/cnsaroot/Boot/WinPE.wim. This file can be used by anyWindows OS version,
unless you change the path names.

Note

The command bcdedit.exe used to create BCD files is commonly available in theWindows operating systems
root directory: c:\windows\system32.

Before You Begin

Create a custom WinPE and copy the PXE supported files

Procedure

Step 1 Navigate to the directory that contains the bcdedit.exe command and run the following sequence of commands
to create the BCD file.
The bcdedit.exe command is commonly available in the Windows operating systems root directory:
c:\windows\system32.

Step 2 bcdedit.exe /createstore BCD
Step 3 bcdedit.exe /store BCD /create {ramdiskoptions} /d "Ramdisk options"
Step 4 bcdedit.exe /store BCD /set {ramdiskoptions} ramdisksdidevice boot
Step 5 bcdedit.exe /store BCD /set {ramdiskoptions} ramdisksdipath \Boot\boot.sdi
Step 6 bcdedit.exe /store BCD /create /d "My WinPE Boot Image" /application osloader

At this point, the GUID is displayed. Replace {a20f8db8-7459-11e2-8ec3-00155d37efa7} in the following
steps with the GUID from your system.
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Step 7 bcdedit.exe /store BCD /set {a20f8db8-7459-11e2-8ec3-00155d37efa7} systemroot \Windows
Step 8 bcdedit.exe /store BCD /set {a20f8db8-7459-11e2-8ec3-00155d37efa7} detecthal Yes
Step 9 bcdedit.exe /store BCD /set {a20f8db8-7459-11e2-8ec3-00155d37efa7} winpe Yes
Step 10 bcdedit.exe /store BCD /set {a20f8db8-7459-11e2-8ec3-00155d37efa7} osdevice

ramdisk=[boot]\Boot\WinPE.wim,{ramdiskoptions}
Step 11 bcdedit.exe /store BCD /set {a20f8db8-7459-11e2-8ec3-00155d37efa7} device

ramdisk=[boot]\Boot\WinPE.wim,{ramdiskoptions}
Step 12 One of the following:

• bcdedit.exe /store BCD /create {bootmgr} /d "Windows 2012r2 BootManager"

• bcdedit.exe /store BCD /create {bootmgr} /d "Windows 2012 BootManager"

Step 13 bcdedit.exe /store BCD /set {bootmgr} timeout 30
Step 14 bcdedit.exe /store BCD /displayorder {a20f8db8-7459-11e2-8ec3-00155d37efa7}
Step 15 Use the following command to verify that the configuration names are correct: bcdedit.exe /store BCD /enum

all

What to Do Next

Copy the Windows installation ISO image to the server folder.

Copying the Windows Installation Files to the Server Folder

Before You Begin

You must have the following in place:

• Customized winPE.wim and PXE boot files in the opt/cnsaroot/Boot directory in the Bare
Metal Agent VM.

• Configured BCD file in the /opt/cnsaroot/Boot directory in the Bare Metal Agent VM.

•Windows installation files (ISO version).

Procedure

Step 1 Extract the downloaded ISO that you obtained and validated.
Step 2 Copy the folders and files from the downloaded ISO to the appropriate directory in the Bare Metal Agent

VM.
Server PathWindows OS Version

/samba/Win2k12R2x64Windows 2012 R2

/samba/Win2k12x64Windows 2012
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Do not change the folder paths, filenames, or folder
names.

Note

The following is a sample of the contents of a Win2k12R2x64 folder after the Window installation files
have been copied to it:

boot
efi
sources
support
autorun.inf
bootmgr.efi
setup.exe

Step 3 Open the /samba/notifications/notify.ps1 file and verify that the IP address matches the PXE
IP address of Bare Metal Agent.

Windows Server 2016 x64 Operating System Images
Cisco UCS Director Bare Metal Agent supports PXE boot and installation operations for Windows 2016 x64
OS images and PXE boot tasks used in bare metal provisioning workflows.

Prerequisites for Setting Up Windows Server 2016 x64 Operating System
Images

Before you can install a Windows 2016 OS image in the /opt/cnsaroot/Boot directory of the Bare
Metal Agent VM, you must install and set up the following prerequisites:

•WindowsAssessment andDeployment Kit (WindowsADK, version 8.0 or later recommended, depending
on the Windows version compatibilities with respect to the WinPE.wim file)

• A customized Windows Preinstallation Environment (WinPE.wim) and PXE supporting files

• Boot Configuration Data (BCD) file

•Windows installation files (the files extracted from the ISO)

You do not need to manually create a Windows answer file when setting up Windows OS images. Bare
Metal Agent builds the Windows answer file necessary to support your PXE Boot request, based on the
information you provide when you create the PXE boot request.

Note

To install and set up the images, download the following:

•Windows Assessment and Deployment Kit that supports Windows Server 2016. For more information,
see http://technet.microsoft.com/en-us/library/dn613859.aspx.

•Windows Server 2016 x64.
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We recommend that you use the ISO download file, which contains all editions, including Standard,
Enterprise, Datacenter, andWeb. You can typically remove all editions except for Standard and Datacenter.

Tip

After the system image is in place, perform the following additional procedures:

• Set up WinPE and copy the supporting files to the Network Service Agent server for the PXE boot.

• Copy the Windows installation files to the server path.

Creating a Custom WinPE and Copying the PXE Supported Files for Windows
2016

The /opt/cnsaroot/Boot folder is static, and each Bare Metal Agent can have only one boot folder.Note

Before You Begin

Complete the prerequisites listed in Prerequisites for Setting UpWindows Server 2016 x64 Operating System
Images, on page 54.

Procedure

Step 1 Download an ADK version that supports Windows 2016 and install it on a Windows 2016 machine.
When you specify the features to include in the download, you must include the Windows PE and
Deployment Tools.

Note

Step 2 Navigate to the Windows Pre-installation Environment folder in the ADK tools and execute copype.cmd to
create the files that WinPE requires.

Copype.cmd amd64 C:\WinPE_amd64

The target directory contains the WinPE.wim file. The latest ADK versions create a boot.vim file, which
needs to be renamed to WinPE.wim.

Step 3 In theWindows machine that has the ADK tools installed, create a directory. Copy the WinPE.wim file from
/opt/cnsaroot/Boot to the directory you have created.

Step 4 At the command line, navigate to the ADK installed folder.
Step 5 Add the drivers from their folder locations to the WinPE image.

Use the following DISM.exe command when you know the paths to the drivers that you want to add.

// The DISM.exe command mounts the WinPE to a folder.
// In this example, the c:\win2k16x64 directory and the \mount subdirectory have been created
before running the command.
DISM.exe /mount-wim /wimfile:c:\win2k16x64\WinPE.wim /index:1 /mountdir:c:\win2k16x64\mount

// To add individual driver files to WinPE image, use the following format.
DISM.exe /image:c:\win2k16x64\mount /Add-Driver /driver:C:\test\drivers\1.inf
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/driver:C:\test\drivers\2.inf /driver:C:\test\drivers\3.inf

Use the following DISM.exe command when you do not know the paths to the drivers that you want to add
and need to query all subfolders.

// The DISM.exe command mounts the WinPE to a folder.
// In this example, the c:\win2k16x64 directory and the \mount subdirectory have been created
before running the command.
DISM.exe /mount-wim /wimfile:c:\win2k16x64\WinPE.wim /index:1 /mountdir:c:\win2k16x64\mount

// To add individual driver files to WinPE image, use the following format.
DISM.exe /image:c:\win2k16x64\mount /Add-Driver /driver:c:\test\drivers /Recurse

Step 6 Mount WinPE.wim to a folder.
Step 7 In WinPE.wim, add the required PowerShell packages and edit the paths in each command with the correct

mount point and ADK installation path for your environment.
The PowerShell packages and file names that you need to add to WinPE.wim are dependent upon
the version of Windows and WinPE.wim.To determine which PowerShell packages you need to
add, see the compliance report on the Microsoft website. For information about the commands to
add the necessary packages for PowerShell, see theWinPE: Adding PowerShell support to Windows
PE Technet Page. The PowerShell package files shown below are provided for reference and will
vary depending on the version of Windows and WinPE.wim.

Note

\\ Sample PowerShell package files.
\\ The PowerShell packages and file names that you need to add to WinPE.wim vary depending
on the version of Windows and WinPE.wim.

Dism /Add-Package /Image:"C:\win2k16x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\10\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\WinPE-WMI.cab"

Dism /Add-Package /Image:"C:\win2k16x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\10\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\en-us\WinPE-WMI_en-us.cab"

Dism /Add-Package /Image:"C:\win2k16x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\10\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\WinPE-NetFX.cab"

Dism /Add-Package /Image:"C:\win2k16x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\10\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\en-us\WinPE-NetFX_en-us.cab"

Dism /Add-Package /Image:"C:\win2k16x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\10\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\WinPE-Scripting.cab"

Dism /Add-Package /Image:"C:\win2k16x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\10\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\en-us\WinPE-Scripting_en-us.cab"

Dism /Add-Package /Image:"C:\win2k16x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\10\Assessment and Deployment Kit\Windows Preinstallation
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Environment\amd64\WinPE_OCs\WinPE-PowerShell.cab"

Dism /Add-Package /Image:"C:\win2k16x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\10\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\en-us\WinPE-PowerShell_en-us.cab"

Dism /Add-Package /Image:"C:\win2k16x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\10\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\WinPE-StorageWMI.cab"

Dism /Add-Package /Image:"C:\win2k16x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\10\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\en-us\WinPE-StorageWMI_en-us.cab"

Dism /Add-Package /Image:"C:\win2k16x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\10\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\WinPE-DismCmdlets.cab"

Dism /Add-Package /Image:"C:\win2k16x64\mount" /PackagePath:"C:\Program Files\Windows
Kits\10\Assessment and Deployment Kit\Windows Preinstallation
Environment\amd64\WinPE_OCs\en-us\WinPE-DismCmdlets_en-us.cab"

Step 8 Navigate to \windows\system32 in the mount folder. In the startnet.cmd, update the IP address for
Bare Metal Agent.
Note • Do not change any information in the startnet.cmd file, except for the Bare Metal Agent

IP address.

• Make sure that you modify the IP addresses in all the entries so that they point to the BareMetal
Agent IP address.

• All drive letter references (such as the reference to an R: drive) must match in both the
startnet.cmd file and the Windows answer file. By default, Bare Metal Agent comes with
an R: drive letter assignment.

Step 9 Unmount the WinPE, commit the changes, and copy the file to the /opt/cnsaroot/Boot directory in
the Bare Metal Agent VM.
DISM.exe /Unmount-Wim /Mountdir:c:\win2k16x64\mount /commit

What to Do Next

Install and set up (as necessary) the Boot Configuration Data (BCD) file.

Installing and Setting Up the Boot Configuration Data File
The Boot Configuration Data (BCD) file contains the boot configuration parameters. It controls how the
operating system is started inWindows and is used to load the base kernel (WinPE.wim) from the PXE server.
You do not need to create a BCD file. Bare Metal Agent provides a BCD file with default paths that you can
use.

By default, the BCD file points to the /Boot/WinPE.wim and boot.sdi files. These filenames are case
sensitive.

Cisco UCS Director Bare Metal Agent Installation and Configuration Guide, Release 6.5    
57

Adding Windows OS Images
Installing and Setting Up the Boot Configuration Data File



We recommend that you use a set of standard names for Bare Metal Agent configuration purposes. The
folder name should be Boot. The winpe file name should be WinPE.wim. Use corresponding filenames
such as boot.sdi. The created BCD file should be in uppercase, and this file will not have any file extension.
Bare Metal Agent delivers the BCD file to /opt/cnsaroot/Boot, which contains a default path
pointing to /opt/cnsaroot/Boot/WinPE.wim. This file can be used by anyWindows OS version,
unless you change the path names.

Note

The command bcdedit.exe used to create BCD files is commonly available in theWindows operating systems
root directory: c:\windows\system32.

Before You Begin

Create a custom WinPE and copy the PXE supported files

Procedure

Step 1 Navigate to the directory that contains the bcdedit.exe command and run the following sequence of commands
to create the BCD file.
The bcdedit.exe command is commonly available in the Windows operating systems root directory:
c:\windows\system32.

Step 2 bcdedit.exe /createstore BCD
Step 3 bcdedit.exe /store BCD /create {ramdiskoptions} /d "Ramdisk options"
Step 4 bcdedit.exe /store BCD /set {ramdiskoptions} ramdisksdidevice boot
Step 5 bcdedit.exe /store BCD /set {ramdiskoptions} ramdisksdipath \Boot\boot.sdi
Step 6 bcdedit.exe /store BCD /create /d "My WinPE Boot Image" /application osloader

At this point, the GUID is displayed. Replace {a20f8db8-7459-11e2-8ec3-00155d37efa7} in the following
steps with the GUID from your system.

Step 7 bcdedit.exe /store BCD /set {a20f8db8-7459-11e2-8ec3-00155d37efa7} systemroot \Windows
Step 8 bcdedit.exe /store BCD /set {a20f8db8-7459-11e2-8ec3-00155d37efa7} detecthal Yes
Step 9 bcdedit.exe /store BCD /set {a20f8db8-7459-11e2-8ec3-00155d37efa7} winpe Yes
Step 10 bcdedit.exe /store BCD /set {a20f8db8-7459-11e2-8ec3-00155d37efa7} osdevice

ramdisk=[boot]\Boot\WinPE.wim,{ramdiskoptions}
Step 11 bcdedit.exe /store BCD /set {a20f8db8-7459-11e2-8ec3-00155d37efa7} device

ramdisk=[boot]\Boot\WinPE.wim,{ramdiskoptions}
Step 12 bcdedit.exe /store BCD /create {bootmgr} /d "Windows 2016 BootManager"
Step 13 bcdedit.exe /store BCD /set {bootmgr} timeout 30
Step 14 bcdedit.exe /store BCD /displayorder {a20f8db8-7459-11e2-8ec3-00155d37efa7}
Step 15 Use the following command to verify that the configuration names are correct: bcdedit.exe /store BCD /enum

all

What to Do Next

Copy the Windows installation ISO image to the server folder.

   Cisco UCS Director Bare Metal Agent Installation and Configuration Guide, Release 6.5
58

Adding Windows OS Images
Installing and Setting Up the Boot Configuration Data File



Copying the Windows Installation Files to the Server Folder

Before You Begin

You must have the following in place:

• Customized winPE.wim and PXE boot files in the opt/cnsaroot/Boot directory in the Bare
Metal Agent VM.

• Configured BCD file in the /opt/cnsaroot/Boot directory in the Bare Metal Agent VM.

•Windows installation files (ISO version).

Procedure

Step 1 Extract the downloaded ISO that you obtained and validated.
Step 2 Copy the folders and files from the downloaded ISO to the appropriate directory in the Bare Metal Agent

VM.
Server PathWindows OS Version

/samba/Win2k16x64Windows 2016

Do not change the folder paths, filenames, or folder
names.

Note

The following is a sample of the contents of a Win2k16x64 folder after the Window installation files have
been copied to it:

boot
efi
sources
support
autorun.inf
bootmgr.efi
setup.exe

Step 3 Open the /samba/notifications/notify.ps1 file and verify that the IP address matches the PXE
IP address of Bare Metal Agent.

Using MEMDISK for Deploying Multiple Versions of Windows
Simultaneously

Currently, Bare Metal Agent adopts the Microsoft Windows PXE boot process, which expects WinPE.wim
to be placed in the /tftproot/Boot folder. This process results in maintaining a single WinPE for deploying
multiple versions of Windows simultaneously from Bare Metal Agent. To use different WinPE files for
deploying different versions of Windows simultaneously, you have to rename eachWinPE.wim file manually
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according to the BCD file. To overcome this limitation, you can use MEMDISK to boot the ISO file. The
MEMDISK file is available in the /opt/cnsaroot folder in Bare Metal Agent, as part of syslinux. When you
use MEMDISK , the ISO file can be placed anywhere in the TFTP root directory in Bare Metal Agent.

Requirements for Using MEMDISK
To use MEMDISK in Bare Metal Agent, create a bootable WINPE ISO file and then modify the MAC file
template.

Creating Bootable WINPE File for Windows Server 2008 R2, 2012, 2012 R2, or 2016

Before You Begin

Install Windows Assessment and Deployment Kit (Windows ADK) that is compatible with the Windows
Server version you want to deploy.

Procedure

Step 1 Launch the Deployment and Imaging Tools Environment.
Step 2 Create a new WinPE environment folder:

Copype.cmd amd64 C:\WinPE_amd64

The ‘copype.cmd’ command creates a "WinPE_amd64" folder with three subfolders: fwfiles, media andmount.
The folders created are based on the ADK version.

Step 3 Delete bootfix.bin from /media/Boot folder.
Deleting bootfix.bin helps you avoid pressing a key to boot the ISO if any partition is detected on the hard
disk drive.

Step 4 Create the customized WinPE.wim (available in the /media/Sources folder) by making the following
changes:
a) Inject PowerShell packages.
b) Inject drivers (if any)
c) Edit Startnet.cmd.
For injecting PowerShell packages and editing Startnet.cmd for theWindows Server version you are deploying,
see

• Customizing and Copying the WinPE.wim and PXE Boot Files for Windows 2008 R2, on page 42

• Creating a Custom WinPE and Copying the PXE Supported Files for Windows 2012, on page 47

• Creating a Custom WinPE and Copying the PXE Supported Files for Windows 2012 R2, on page 49

Step 5 Execute the following command from the terminal to create the bootable WINPE ISO file:
Makewinpemedia.cmd /iso C:\WinPE_amd64 C:\WinPE_amd64.iso
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Modifying MAC File Template
To support the MEMDISK boot process in Bare Metal Agent, the MAC file template has to be modified. The
/opt/cnsaroot/templates folder in Bare Metal Agent has the configuration files templates for all the
three versions of Windows.

As the MAC template file is static, you can either implement the Windows PXE boot process or the
MEMDISK boot process. You cannot implement both of them.

Note

Procedure

PurposeCommand or Action

After creating the bootable WINPE ISO file, create a folder called 'windows' under
/opt/cnsaroot (folder name is not static) in the BMA tftp root directory.

Step 1

Copy the working bootable WINPE ISO file to the windows folder.Step 2

When the MEMDISK module is loaded, it adds the ISO image to the memory
(specified as INITRD in the MAC File).

Step 3

Pass the two parameters, iso and raw, toMEMDISK using APPEND. (This instructs
MEMDISK to load an ISO image and enter in protected mode directly).

Step 4

Example:
For example, if you want to bootWindows Server 2012 R2 usingMEMDISK, make
the following changes in pxe.cfg available in the Win2k12R2x64 folder:

default 1
timeout 100
prompt 1
label 1
KERNEL memdisk
INITRD /windows/WinPE.iso
APPEND iso raw
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C H A P T E R  8
Provisioning OS Images through Orchestration
Workflow Tasks

This chapter contains the following sections:

• Orchestration Workflow Tasks for PXE Boot, page 63

• Prerequisites for Workflows with PXE Boot Tasks, page 64

• Execution of the Setup PXE Boot Tasks , page 65

• Determining the Windows OS Edition, page 66

• Inputs for the Setup PXE Boot Task, page 67

• Inputs for the Setup PXE Boot with BMA Selection Task, page 70

• Inputs for the Setup Windows PXE Boot Task, page 73

• Outputs from the Setup PXE Boot Task and Setup Windows PXE Boot Task, page 76

• Creating a PXE Boot Request in Cisco UCS Director, page 76

• Viewing the PXE Request Configuration Files, page 80

• PXE Boot States, page 80

• Monitor PXE Boot Setup Task, page 81

• Remove PXE Boot Setup Task, page 81

• Injecting Drivers When Installing RHEL 7 or CentOS 7 on UCS Modular Servers, page 82

• Simultaneous Provisioning of Windows Server Operating Systems, page 83

Orchestration Workflow Tasks for PXE Boot
The orchestration workflow tasks for PXE boot enable you to create workflows within Cisco UCS Director
that use the functionality of Cisco UCS Director Bare Metal Agent.

When you include any of the PXE boot tasks in an orchestration workflow, the task prepares the Bare Metal
Agent environment to receive a PXE install request for a physical or virtual machine.
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The values for each input required within the task can be supplied in one of the following ways:

• As user inputs by the user who executes the workflow

• Through outputs from a previous task in the workflow

• Through admin inputs that are assigned by the Cisco UCS Director user who creates the workflow

The following orchestration workflow tasks are available:

• Setup PXE Boot task

• Setup PXE Boot with BMA Selection task

• Setup Windows PXE Boot task

• Monitor PXE Boot task

• Remove PXE Boot Setup task

To set up a PXE boot for a Windows Server operating system, you must use the PXE boot setup task that
is defined specifically for Windows. To set up a PXE boot for all other supported operating systems, use
the Setup PXE Boot task or the Setup PXE Boot with BMA Selection task.

Note

You can access these workflow tasks in the Network Services area of the Cisco UCS Director Workflow
Designer Task Library.

Most inputs and outputs are the same for the Setup PXE Boot task, the Setup PXE Boot with BMA Selection
task, and the Setup Windows PXE Boot task, with the following notable exceptions:

• The Setup PXE Boot with BMA Selection task has an input field for selecting the target Bare Metal
Agent.

• The Setup PXE Boot task does not have an option to select the target Bare Metal Agent. This legacy
workflow task uses the default Bare Metal Agent as the target Bare Metal Agent.

• The Setup Windows PXE boot task has an input field for selecting the target Bare Metal Agent.

For the legacy Setup PXE Boot task, the default Bare Metal Agent is the first Bare Metal Agent added.
However, you can change the default Bare Metal Agent. See Changing the Default Bare Metal Agent
Account, on page 23.

Tip

Prerequisites for Workflows with PXE Boot Tasks
If you plan to create orchestration workflows that include one or more of the PXE boot tasks, your Cisco UCS
Director and Cisco UCS Director Bare Metal Agent environment must meet the following prerequisites:

• CiscoUCSDirector has been installed and the network interface configured as described in the appropriate
Cisco UCS Director installation guide.

• Cisco UCS Director is reachable through a web browser and you can log in.
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• Cisco UCS Director Bare Metal Agent has been installed as described in Installing Cisco UCS Director
Bare Metal Agent, on page 9.

• The required network/VLAN has been configured as the native, or default, VLAN on the server. For
example, for a Cisco UCS server, edit the vNIC template associated with the server and choose the PXE
network/VLAN as the native VLAN. You can perform this configuration through an orchestration
workflow.

• Each BareMetal Agent account that you want to use in a workflow has been set up, is active, has a tested
connection, and has services that have been enabled and started.

Execution of the Setup PXE Boot Tasks
The following Setup PXE Boot tasks are available for use in workflows:

• Setup PXE Boot task

• Setup PXE Boot with BMA Selection task

• Setup Windows PXE Boot task

Each time that one of these tasks is executed within a workflow, Cisco UCSDirector uses the following values
for the inputs to complete a set of configuration files for that particular PXE request:

• Dynamic values received from previous tasks in the workflow or from the user at run-time.

• Static values that you enter when you create the workflow.

• Template configuration files—the ks.cfg Kickstart files—that were created when the chosen operating
system was added to Bare Metal Agent. For more information about these files, see Sample Operating
System Configuration Template Files, on page 89.

When the workflow is executed, Bare Metal Agent and Cisco UCS Director use the values gathered through
the task and perform the following steps to prepare for a PXE installation request on the specified server:

NotesActionStep

You can view these PXE requests and PXE IDs
on the PXE Boot Requests tab for a pod in Cisco
UCS Director.

Creates a new directory in the Cisco UCS
Director Bare Metal Agent VM that
corresponds to the PXE ID request in the
/opt/cnsaroot/web/ks-repository/
directory.

1

For example, to create the customized ks.cfg
file for the PXE installation,Cisco UCS Director
takes the template ks.cfg file from the
/opt/cnsaroot/templates/Operating_System/
directory and fills in the variables provided in the
Setup PXE Boot task. This customized ks.cfg
file is saved in a directory that corresponds to the
PXE ID, such as
/opt/cnsaroot/web/ks-repository/PXE_ID.

Adds the required unique configuration files
to the
/opt/cnsaroot/web/ks-repository/PXE_ID
directory for the PXE installation specific to
this request, including the ks.cfg, or
Kickstart Configuration, file. Depending upon
the operating system, other configuration files
might be added to this directory, such as the
boot.cfg file required for an ESXi
installation.

2
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NotesActionStep

The workflow appends "01-" to the MAC address
of the server to create the filename. This file
includes information about where the image files
are located and is generated through the pxe.cfg
file in the
/opt/cnsaroot/templates/Operating_System/
directory.

Creates a file corresponding to the MAC
address of the server in the
/opt/cnsaroot/pxelinux.cfg/
directory in the Bare Metal Agent VM.

3

Bare Metal Agent automatically creates Windows answer files for the supported operating systems. The
same answer file is used for local boot and SAN boot. TheWindows installation does not support multi-path
SAN boot, but you can use a single path workflow to achieve SAN boot.

Note

Determining the Windows OS Edition
The exact Windows OS edition is required for successful PXE boot of a Windows Server image. You must
enter the exact character string used by Windows PE (WinPE). This string is case sensitive. The Windows
OS edition follows a consistent naming convention. Some examples of OS editions are as follows:
Windows Server 2008 R2 SERVERSTANDARD
Windows Server 2008 R2 SERVERSTANDARDCORE
Windows Server 2008 R2 SERVERENTERPRISE
Windows Server 2008 R2 SERVERENTERPRISECORE
Windows Server 2008 R2 SERVERDATACENTER
Windows Server 2008 R2 SERVERDATACENTERCORE
Windows Server 2008 R2 SERVERWEB
Windows Server 2008 R2 SERVERWEBCORE
Windows Server 2012 SERVERSTANDARD
Windows Server 2012 SERVERSTANDARDCORE
Windows Server 2012 R2 SERVERSTANDARD
Windows Server 2012 R2 SERVERSTANDARDCORE
Windows Server 2012 R2 SERVERDATACENTER
Windows Server 2012 R2 SERVERDATACENTERCORE

Procedure

Step 1 Navigate to the extracted ISO files for the Windows OS image.
Step 2 For a Windows 2012 R2 image, navigate to C:\win2k12r2\sources\install.wim and use a

PowerShell cmdlet to find the edition.
An example of the use of this cmdlet is as follows:

PS C:\Windows\system32> Get-WindowsImage -ImagePath
C:\win2k12r2\sources\install.wim
Index : 1
Name : Windows Server 2012 R2 SERVERSTANDARDCORE
Description : Windows Server 2012 R2 SERVERSTANDARDCORE
Size : 6,653,342,051 bytes
Index : 2
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Name : Windows Server 2012 R2 SERVERSTANDARD
Description : Windows Server 2012 R2 SERVERSTANDARD
Size : 11,807,528,410 bytes
Index : 3
Name : Windows Server 2012 R2 SERVERDATACENTERCORE
Description : Windows Server 2012 R2 SERVERDATACENTERCORE
Size : 6,653,031,430 bytes
<etcetera>

Step 3 For a Windows 2008 image, use the DISM.EXE syntax from the computer on which you installed the WAIK
tools.
An example of the use of this syntax is as follows:

C:\Program Files\Windows AIK\Tools\>dism
/get-wiminfo /wimfile:e:\\Win2k8r2x64\sources\install.wim
Deployment Image Servicing and Management tool
Version: 6.1.7600.16385
Details for image : e:\Username_Windowsbits\Win2k8r2x64\sources\install.wim
Index : 1
Name : Windows Server 2008 R2 SERVERSTANDARD
Description : Windows Server 2008 R2 SERVERSTANDARD
Size : 10,510,503,883 bytes
Index : 2
Name : Windows Server 2008 R2 SERVERSTANDARDCORE
Description : Windows Server 2008 R2 SERVERSTANDARDCORE
Size : 3,563,695,852 bytes
<etcetera>

Inputs for the Setup PXE Boot Task
The following table describes the inputs for the Setup PXE Boot task. Because the information for one or
more of these inputs can be obtained from a previous task or from a user at run-time, the values for these
inputs can be dynamic and change with each execution of the workflow.

For legacy Setup PXE Boot tasks, the default Bare Metal Agent is the first Bare Metal Agent added.
However, you can change the default Bare Metal Agent. See Changing the Default Bare Metal Agent
Account, on page 23.

Note
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Table 2: Setup PXE Boot Task Inputs

DescriptionInput

Choose the network boot manager that you want to use. Choose one
of the following:

• PXE—PXE supports only TFTP protocol

• iPXE-BIOS—iPXE-BIOS supports HTTP protocol by default

• iPXE-UEFI—iPXE-UEFI supports TFTP protocol by default.
However, you can modify the ipxe-uefi.cfg to support
the HTTP protocol. See Setting Up UEFI as Network Boot
Manager.

The default option is PXE.

Network BootManager drop-down
list

The OS image that you want this PXE or iPXE boot request to install
on the server. The drop-down list includes all OS images that have
been created and are available for PXE or iPXE installation.

OS Type drop-down list

The MAC address of the server that requires the PXE or iPXE
installation. This input is typically mapped to theMAC address output
from the Create UCS Service Profile task.

Server MAC Address

Choose the configuration type. Choose one of the following:

• Static

• DHCP

IP Configuration Type drop-down
list

The IP Address that you want to assign to the server. This IP address
is given to the server after the PXE or iPXE installation process is
complete, and is the final IP address for the server. This field is
displayed only when you select the Static option in the IP
Configuration Type drop-down list.

This IP address can be on a different network or subnet than the PXE
or iPXE network or Management network that you configured for
Bare Metal Agent.

Server IP Address field

The subnet mask that you want to assign to the server after the PXE
or iPXE installation process is complete. This field is displayed only
when you select the Static option in the IP Configuration Type
drop-down list.

Server Net Mask field

The hostname that you want to assign to the server after the PXE or
iPXE installation process is complete.

Server Host Name field
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DescriptionInput

The default gateway IP address that you want to assign to the server
after the PXE or iPXE installation process is complete. This field is
displayed only when you select the Static option in the IP
Configuration Type drop-down list.

Server Gateway field

(Optional) The DNS server that you want the server to use. This field
is displayed only when you select the Static option in the IP
Configuration Type drop-down list.

If no DNS server is required, leave this input blank.

Server Name Server field

(Optional) The VLAN ID that you want to assign to the management
interface on the server after the PXE or iPXE installation process is
complete.

This setting is typically used in ESX/ESXi deployments where VLAN
tagging is prevalent on the virtual switch. It sets the VLAN ID for
tagging on the management vmkernel port.

Management VLAN field

The password that you want to assign to the root user on the server.Root Password field

The time zone in which you want to configure the server.Timezone field
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DescriptionInput

Interface to add, edit, or delete single-line parameters that are used
additionally for the PXE or iPXE boot request. You can add multiple
parameters using this interface.

To add an additional parameter, click (+). In the Add Additional
Parameter box that appears, enter the parameter name and the value
for the parameter. Use the Edit button to modify the parameter name
or its value. Use the Delete button to delete a parameter.

For example, you can use an additional parameter to customize the
ks.cfg file template and provide a value for the parameter here. The
parameter is then updated with the appropriate value in the ks.cfg file
template.

Suppose the existing firewall configuration in ks.cfg is as follows:

# Firewall configuration
firewall --disabled
You can customize the configuration as following:

# Firewall configuration
firewall —$FIREWALL_CONFIG
In the Additional Parameter interface here, you can include
FIREWALL_CONFIG as the parameter name and provide the value as
disabled. The value of the parameter can also be mapped to a user
input ${variable}. This parameter is updated with the appropriate
value in the ks.cfg file template.

The ks.cfg file templates used by Bare Metal Agent are available in
/opt/cnsaroot/templates/IMAGE_CATALOG_NAME/ks.cfg.
For example, the ks.cfg file for CentOS 6.0 is available in
/opt/cnsaroot/templates/CentOS60/ks.cfg

In the template files to retain dollar sign ($) and backslash
(\), you must include a backslash (\) before the character.

Note

Additional Parameters interface

Inputs for the Setup PXE Boot with BMA Selection Task
The following table describes the inputs for the Setup PXE Boot with BMA Selection task. Because the
information for one or more of these inputs can be obtained from a previous task or from a user at run-time,
the values for these inputs can be dynamic and change with each execution of the workflow.

The Setup PXE Boot with BMA Selection task does not support the Windows OS and does not accept
inputs for that OS.

Note
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Table 3: Setup PXE Boot with BMA Selection Task Inputs

DescriptionInput

Choose the network boot manager that you want to use. Choose one
of the following:

• PXE—PXE supports only TFTP protocol

• iPXE-BIOS—iPXE-BIOS supports HTTP protocol by default

• iPXE-UEFI—iPXE-UEFI supports TFTP protocol by default.
However, you can modify the ipxe-uefi.cfg to support
the HTTP protocol. See Setting Up UEFI as Network Boot
Manager.

The default option is PXE.

Network BootManager drop-down
list

The Bare Metal Agent accounts that have been added to Cisco UCS
Director and are available for use.

Target BMA field

The OS image that you want this PXE or iPXE boot request to install
on the server. The drop-down list includes all OS images that have
been created and are available for PXE or iPXE installation.

OS Type drop-down list

The MAC address of the server that requires the PXE or iPXE
installation. This input is typically mapped to theMAC address output
from the Create UCS Service Profile task.

Server MAC Address

Choose the configuration type. Choose one of the following:

• Static

• DHCP

IP Configuration Type drop-down
list

The IP Address that you want to assign to the server. This IP address
is given to the server after the PXE or iPXE installation process is
complete and is the final IP address for the server. This field is
displayed only when you select the Static option in the IP
Configuration Type drop-down list.

This IP address can be on a different network or subnet than the PXE
or iPXE network or Management network that you configured for
Bare Metal Agent.

Server Address field

The subnet mask that you want to assign to the server after the PXE
or iPXE installation process is complete. This field is displayed only
when you select the Static option in the IP Configuration Type
drop-down list.

Server Net Mask field

The hostname that you want to assign to the server after the PXE or
iPXE installation process is complete.

Server Host Name field
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DescriptionInput

The default gateway IP address that you want to assign to the server
after the PXE or iPXE installation process is complete. This field is
displayed only when you select the Static option in the IP
Configuration Type drop-down list.

Server Gateway field

(Optional) The DNS server that you want the server to use. This field
is displayed only when you select the Static option in the IP
Configuration Type drop-down list.

If no DNS server is required, leave this input blank.

Server Name Server field

(Optional) The VLAN ID that you want to assign to the management
interface on the server after the PXE or iPXE installation process is
complete.

This setting is typically used in ESX/ESXi deployments where VLAN
tagging is prevalent on the virtual switch. It sets the VLAN ID for
tagging on the management vmkernel port.

Management VLAN field

The password that you want to assign to the root user on the server.Root Password field

The time zone in which you want to configure the server.Timezone field
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DescriptionInput

Interface to add, edit, or delete single-line parameters that are used
additionally for the PXE or iPXE boot request. You can add multiple
parameters using this interface.

To add an additional parameter, click (+). In the Add Additional
Parameter box that appears, enter the parameter name and the value
for the parameter. Use the Edit button to modify the parameter name
or its value. Use the Delete button to delete a parameter.

For example, you can use an additional parameter to customize the
ks.cfg file template and provide a value for the parameter here. The
parameter is then updated with the appropriate value in the ks.cfg file
template.

Suppose the existing firewall configuration in ks.cfg is as follows:

# Firewall configuration
firewall --disabled
You can customize the configuration as following:

# Firewall configuration
firewall —$FIREWALL_CONFIG
In the Additional Parameter interface here, you can include
FIREWALL_CONFIG as the parameter name and provide the value as
disabled. The value of the parameter can also be mapped to a user
input ${variable}. This parameter is updated with the appropriate
value in the ks.cfg file template.

The ks.cfg file templates used by Bare Metal Agent are available in
/opt/cnsaroot/templates/IMAGE_CATALOG_NAME/ks.cfg.
For example, the ks.cfg file for CentOS 6.0 is available in
/opt/cnsaroot/templates/CentOS60/ks.cfg

In the template files to retain dollar sign ($) and backslash
(\), you must include a backslash (\) before the character.

Note

Additional Parameters interface

Inputs for the Setup Windows PXE Boot Task
The following table describes the inputs for the Setup Windows PXE Boot task. Because the information for
one or more of these inputs can be obtained from a previous task or from a user at run-time, the values for
these inputs can be dynamic and change with each execution of the workflow.

Bare Metal Agent automatically createsWindows answer files for supportedWindows operating systems.
You can use the same answer file for local boot and SAN boot. TheWindows installation does not support
multi-path SAN boot, but you can use a single path workflow to achieve SAN boot.

Note
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Table 4: Setup Windows PXE Boot Task Inputs

DescriptionInput

Choose the network boot manager that you want to use. Choose one of the following:

• PXE—PXE supports only TFTP protocol

• iPXE-BIOS—iPXE-BIOS supports HTTP protocol by default

• iPXE-UEFI—iPXE-UEFI supports TFTP protocol by default. However, you can
modify the ipxe-uefi.cfg to support the HTTP protocol. See Setting Up
UEFI as Network Boot Manager.

The default option is PXE.

Network Boot
Manager
drop-down list

The Bare Metal Agent accounts that have been added to Cisco UCS Director and are
available for use.

Target BMA field

The OS image that you want this PXE boot request to install on the server. The
drop-down list includes all OS images that have been created in Bare Metal Agent and
are available for PXE installation.

OS Type
drop-down list

Check this check box if you want to enable Hyper-V role for Windows server 2016.
This field is displayed when you choose theWindows 2016(x64) option in theOSType
drop-down list.

If you want to enable Hyper-V onWindows 2012 and Windows 2012 R2, you
should add the <selection name="Microsoft-Hyper-V" state="true" /> in the
answer files available in BMA (under <package> in <servicing> node). The
answers files for Windows 2012 R2 and Windows 2012 are available in
/opt/cnsaroot/templates/Win2k12R2x64/autounatted.xml
and/opt/cnsaroot/templates/Win2k12x64/autounattend.xml
location respectively.

Note

Enable Hyper-V
role for Windows
Server 2016 check
box

TheMAC address of the server that requires the PXE installation. This input is typically
mapped to the MAC address output from the Create UCS Service Profile task.

Server MAC
Address

The Windows OS edition name is required for successful PXE boot of a Windows
Server image. You must enter the exact character string used byWindows PE (WinPE).
This string is case sensitive. For example, enter SERVERSTANDARD or
SERVERENTERPRISE. For more information, see Determining the Windows OS
Edition, on page 66.

This value is used in the Windows answer file, which requires the correct name of the
edition for the image installation process. The OS edition might be different for each
type of Windows OS image.

OS Flavor Name
field

The name of the organization that is associated with the OS product key.

This value is used by the Windows answer file. It could be a division within your
company or the company name.

Organization
Name field

The product key (sometimes called the license key or software key) for the OS.Product Key field
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DescriptionInput

The hostname that you want to assign to the server after the PXE installation process
is complete. Make sure the name complies with NetBIOS name restrictions.

Host Name field

The password that you want to assign to the administrative user on the server.Administrator
Password field

The password that you want to assign to the administrative user on the server.Confirm
Password field

Choose the configuration type. Choose one of the following:

• Static

• DHCP

IP Configuration
Type drop-down
list

The IP Address that you want to assign to the server. This field is displayed only when
you select the Static option in the IP Configuration Type drop-down list.

Server Address
field

The subnet mask that you want to assign to the server after the PXE installation process
is complete. This field is displayed only when you select the Static option in the IP
Configuration Type drop-down list.

Server Net Mask
field

The default gateway IP address that you want to assign to the server after the PXE
installation process is complete. This field is displayed only when you select the Static
option in the IP Configuration Type drop-down list.

Server Gateway
field

The DNS server that you want the server to use. This field is displayed only when you
select the Static option in the IP Configuration Type drop-down list.

Server Name
Server field

The time zone in which you want to configure the server.Timezone field

The size, in GB, of the partition designated for the OS.Disk Partition
Size (GB) field
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DescriptionInput

Interface to add, edit, or delete single-line parameters that are used additionally for the
PXE boot request. You can add multiple parameters using this interface.

To add a parameter, click (+). In the Add Additional Parameter box that appears,
enter the parameter name and the value for the parameter. Use theEdit button to modify
the parameter name or its value. Use the Delete button to delete a parameter.

For example, you can use parameters to provide the minimum requirements for the
Windows answer file. You can define parameters and their values to enhance the answer
file to meet the requirements of your environment. These parameters are updated with
the appropriate values in the Answer file template.

The answer file templates used by Bare Metal Agent are available in the following
locations:

•Windows 2012 R2
x64—/opt/cnsaroot/templates/Win2k12R2x64/autounattend.xml

•Windows 2012
x64—/opt/cnsaroot/templates/Win2k12x64/autounattend.xml

•Windows 2008 R2
x64—/opt/cnsaroot/templates/Win2k8R2x64/autounattend.xml

In the template files to retain dollar sign ($) and backslash (\), you must include
a backslash (\) before the character.

Note

Additional
Parameters field

Outputs from the Setup PXE Boot Task and Setup Windows PXE
Boot Task

The following table describes the outputs from both the Setup PXE Boot task and the Setup Windows PXE
Boot task.

Table 5: Setup PXE Boot and Windows PXE Boot Task Outputs

DescriptionInput

The ID of the PXE boot request that was set up through the
workflow task.

OUTPUT_PXE_BOOT_ID

Creating a PXE Boot Request in Cisco UCS Director
Before You Begin

Create the OS image template that you want to use for the PXE boot in Bare Metal Agent.
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Procedure

Step 1 Choose Administration > Physical Accounts.
Step 2 On the Physical Accounts page, click Bare Metal Agents.
Step 3 Click the row for the Bare Metal Agent account in which you want to set up the PXE boot request.
Step 4 From theMore Actions drop-down list, click View Details.
Step 5 Click PXE Boot Requests.

You can also create a PXE Boot Request by choosing Physical > Compute and navigating to the
pod, in the left pane, in which you want to set up the PXE boot request.

Note

Step 6 Click Add PXE Request.
Step 7 On the Add PXE Boot Request screen, complete the following fields:

DescriptionName

Choose the network boot manager that you want to use. Choose one of the
following:

• PXE—PXE supports only TFTP protocol

• iPXE-BIOS—iPXE-BIOS supports HTTP protocol by default

• iPXE-UEFI—iPXE-UEFI supports TFTP protocol by default.
However, you canmodify theipxe-uefi.cfg to support theHTTP
protocol. See Setting Up UEFI as Network Boot Manager.

The default option is PXE.

Network Boot Manager
drop-down list

The MAC address of the server that requires the PXE or iPXE installation.Server MAC Address field

The hostname to be assigned to the server after the PXE or iPXE installation
process is complete.

Host Name field

The password that you want to assign to the root user on the server. You
need to re-enter this password in the next field to confirm it.

Apply your organization's guidelines for maintaining the security
of this password.

Note

Root Password field

Check this check box if the PXE boot request is for a Windows OS.

After you check this check box, a set of Windows-specific fields appears
in this dialog box.

PXE Request for Windows
check box

Choose the configuration type. Choose one of the following:

• Static

• DHCP

IP Configuration Type
drop-down list

The IP Address that you want to assign to the server. This field is displayed
only when you select the Static option in the IP Configuration Type
drop-down list.

Server Address field
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DescriptionName

The subnet mask that you want to assign to the server after the PXE or
iPXE installation process is complete. This field is displayed only when
you select the Static option in the IP Configuration Type drop-down list.

Server Net Mask field

The default gateway IP address that you want to assign to the server after
the PXE or iPXE installation process is complete. This field is displayed
only when you select the Static option in the IP Configuration Type
drop-down list.

Server Gateway field

The DNS server that you want the server to use. This field is displayed only
when you select the Static option in the IP Configuration Type drop-down
list.

Server Name Server field

Choose the OS image that you want this PXE or iPXE boot request to install
on the server. The drop-down list includes all OS image templates that have
been created and are available for PXE or iPXE installation.

This drop-down list displays in a different location in the dialog box,
depending upon whether you check the PXERequest forWindows check
box.

OS Type drop-down list

(Optional) The VLAN ID that you want to assign to the management
interface on the server after the PXE or iPXE installation process is
complete.

This setting is used in ESX/ESXi deployments where VLAN tagging is
implemented on the virtual switch. It sets the VLAN ID for tagging on the
management vmkernel port.

Management VLAN field

(Required for a Windows OS only) The Windows OS edition name is
required for successful PXE or iPXE boot of a Windows Server image.
You must enter the exact character string used by Windows PE (WinPE).
This string is case sensitive. For example, enter SERVERSTANDARD or
SERVERENTERPRISE. For more information, see Determining the
Windows OS Edition, on page 66.

This value is used in the Windows answer file, which requires the correct
name of the edition for the image installation process. The OS edition name
might be different for each type of Windows OS image.

OS Flavor Name field

(Required for a Windows OS only) The name of the organization that is
associated with the OS product key.

This value is used by theWindows answer file. It could be a division within
your company or the company name.

Organization Name field

(Required for a Windows OS only) The product key (sometimes called the
license key or software key) for the OS.

Product Key field

Choose the time zone in which you want to configure the server.Timezone drop-down list
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DescriptionName

(Required for a Windows OS only) The size, in GB, of the partition
designated for the OS.

Disk Partition Size (GB) field

Interface to add, edit, or delete single-line parameters that are used
additionally for the PXE or iPXE boot request. You can add multiple
parameters using this interface.

To add a parameter, click (+). In the Add Additional Parameter box that
appears, enter the parameter name and the value for the parameter. Use the
Edit button to modify the parameter name or its value. Use the Delete
button to delete a parameter.

For example, for a Windows OS, you can use parameters to provide the
minimum requirements for the Windows answer file. You can define
parameters and their values to enhance the answer file to meet the
requirements of your environment. These parameters are updated with the
appropriate values in the Answer file template.

The answer file templates used by Bare Metal Agent are available in the
following locations:

•Windows 2012 R2
x64—/opt/cnsaroot/templates/Win2k12R2x64/autounattend.xml

•Windows 2012
x64—/opt/cnsaroot/templates/Win2k12x64/autounattend.xml

•Windows 2008 R2
x64—/opt/cnsaroot/templates/Win2k8R2x64/autounattend.xml

Additional Parameters
interface

The static IP address that you want to assign to the server. This IP address
is given to the server after the PXE or iPXE installation process is complete,
and is the final IP address for the server.

This IP address can be on a different network or subnet than the PXE
network orManagement network that you configured for BareMetal Agent.

Server IP Address field

The subnet mask that you want to assign to the server after the PXE or
iPXE installation process is complete.

Network Mask field

The default gateway IP address that you want to assign to the server after
the PXE or iPXE installation process is complete.

Gateway field

The DNS server that you want the server to use.

If no DNS server is required, leave this field blank.

Server Name Server field

Choose the Bare Metal Agent that you want to use for this PXE or iPXE
boot request. The Bare Metal Agent that you choose determines which OS
images are available for the PXE or iPXE boot request.

Target BMA drop-down list
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Step 8 Click Submit.

Information about the new PXE Boot Request will appear as a new row in the PXE Boot Request, displaying
the ID assigned to this request. The information includes the current Status of this request.

What to Do Next

After the PXE or iPXE boot request is in the Submitted state, you must set up the PXE or iPXE environment
to create the Cisco UCS Director configuration files. You can activate a PXE or iPXE boot request that has
a status of Submitted by selecting it and clicking Setup PXE Environment.

Viewing the PXE Request Configuration Files
Procedure

Step 1 Choose Physical > Compute.
Step 2 Choose Administration > Physical Accounts.
Step 3 On the Physical Accounts page, click Bare Metal Agents.
Step 4 Click the row for the Bare Metal Agent account in which you want to set up the PXE boot request.
Step 5 From theMore Actions drop-down list, click View Details.
Step 6 Click PXE Boot Requests.

You can also create a PXE Boot Request by choosing Physical > Compute and navigating to the
pod, in the left pane, in which you want to set up the PXE boot request.

Note

Step 7 Click the row for the PXE boot request for which you want to view the configuration file details.
Step 8 From theMore Actions drop-down list, click View Configuration Files.
Step 9 Choose the configuration file type from the Select the file drop-down list

TheView configuration fileswindow displays the configuration details of the selected file for a PXE request.

PXE Boot States
The following are the PXE boot states for PXE boot requests in Cisco UCS Director:

• Submitted—The PXE boot request has been submitted to Cisco UCS Director.

• Environment Setup—A Submitted PXE boot request has been transferred to Bare Metal Agent and that
the environment required to perform a PXE boot is ready in Bare Metal Agent.

• In Progress—The bare metal server has communicated with BareMetal Agent and the PXE configuration
files and image files are being downloaded.

• Ready—The PXE boot process is complete. The server has booted with the newly installed operating
system and Bare Metal Agent received a success notification from the server that it is ready.
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• Failed—The PXE boot process started, but Bare Metal Agent did not receive a success notification from
the server after the defined wait period expired.

• Archived—The PXE Request task included a rollback or delete.

Monitor PXE Boot Setup Task
When included in an orchestration workflow, theMonitor PXEBoot task monitors a particular PXE ID request
until

• The PXE boot is ready.

• The maximum number of hours specified is reached before the PXE boot is ready.

Inputs for the Monitor PXE Boot Task
The following table describes the inputs for the Monitor PXE Boot Task:

Table 6: Monitor PXE Boot Task Inputs

DescriptionInput

The ID of the PXE boot request that you want to monitor through the workflow.PXE Boot Id

The maximum length of time, in hours, that you want the task to wait for the
PXE boot request to be ready.

Max Wait time (Hours)

Outputs from the Monitor PXE Boot Task
The Monitor PXE Boot task has no outputs.

Remove PXE Boot Setup Task
When included in an orchestration workflow, the Remove PXE Boot Setup task removes the directory and
files that are created by the Setup PXE Boot task for a particular PXE ID request.

Inputs for the Remove PXE Boot Setup Task
The following table describes the inputs for the Remove PXE Boot Setup Task.
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Table 7: Remove PXE Boot Setup Task Inputs

DescriptionInput

The ID of the PXE boot request for which you want to remove the setup
directory and files.

PXE Boot Id

Outputs from the Remove PXE Boot Setup Task
The Remove PXE Boot Setup task has no outputs.

Injecting Drivers When Installing RHEL 7 or CentOS 7 on UCS
Modular Servers

When you install RHEL 7 or CentOS 7 on the UCS servers, manually inject drivers through the PXE.cfg file.
The PXE.cfg file is available in the following location:/opt/cnsaroot/templates/(RHEL 7/CentOS
7 OS Catalog name).

The default PXE.cfg file contains the following line:
append initrd=images/(RHEL 7/CentOS 7 OS Catalog name)/isolinux/initrd.img ramdisk_size=9216
noapic acpi=off ip=dhcp ks=$PXE_KS_URL
ksdevice= inst.repo=http://$PXE_NATIVE_WEBSERVER/(RHEL 7/CentOS 7 OS Catalog name)
net.ifnames=0 biosdevname=0

Here RHEL 7/CentOS 7 OS Catalog name is the name of the OS image provided in the ISO extractor
script while creating the RHEL 7 or CentOS 7 OS image template in Bare Metal Agent.

Note

To inject the drivers, update the location of the drivers in the PXE.cfg file by updating the line as shown
below:
append initrd=images/(RHEL 7/CentOS 7 OS Catalog name)/isolinux/initrd.img ramdisk_size=9216
noapic acpi=off ip=dhcp ks=$PXE_KS_URL
ksdevice= inst.repo=http://$PXE_NATIVE_WEBSERVER/(RHEL 7/CentOS 7 OS Catalog name)
inst.dd=http://$PXE_NATIVE_WEBSERVER/
(RHEL 7/CentOS 7 OS Catalog name )/(name of the driver disk) net.ifnames=0 biosdevname=0

The driver disk should be in the ISO image format and placed in the following location:
/opt/cnsa/images/(RHEL 7/CentOS 7 OS Catalog name)/

Note • Download the driver ISO image from the UCS Servers download page on the Cisco website.

• The parameter inst.dd helps load the driver images during PXE install.
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Simultaneous Provisioning of Windows Server Operating
Systems

You can use Bare Metal Agent to run parallel workflows and simultaneously deploy Windows server images
on multiple bare metal servers.

Prerequisites for Simultaneous Deployment

To ensure that you can perform simultaneous deployment of Windows Server operating system images, you
must perform the appropriate configuration required for the versions of the operating system that are described
in the following topics, including:

• Adding the PowerShell packages to the WinPE.wim file

• Updating startnet.cmd with the IP addresses and other information required for your environment

Bare Metal Workflows

You do not need to make any changes to your existing bare metal provisioning workflows to support
simultaneous deployment of Windows server operating systems.

A PXE boot task in a workflow can only provision one server with a Windows operating system. You cannot
use a single PXE boot task to provision multiple servers, but you can execute PXE boot tasks simultaneously
multiple times.

Maximum Number of Simultaneous Deployments

The maximum number of simultaneous deployments is dependent upon the bandwidth of your TFTP and
PXE networks.

Minimum Supported Level of Bare Metal Agent

Simultaneous deployment of Windows server operating systems requires a minium of Bare Metal Agent,
Release 5.4. It is not supported in earlier releases of Bare Metal Agent.

Files and Folders Used In Simultaneous Deployment
The following files and folders are used during simultaneous deployment of Windows operating systems:

PXElinux.cfg File

The PXElinux.cfg file contains the MAC addresses for each of the servers and points to the WinPE.wim
file.

Samba Folder

The /samba folder contains a folder for each of the following items. Additional information about the script
and folder is provided below.

•Windows images to be deployed on the bare metal servers
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• EnRoute.ps1 script

• as-repository folder

AS-Repository Folder

The /samba/as-repository folder contains a folder for each MAC address of the servers for which a
Windows operating is to be deployed. The PXE boot task creates and stores a separate Windows answer file
for each of these servers in the appropriate MAC address folder. This folder might not be created until after
the first PXE boot workflow is run.

EnRoute.ps1 Script

The EnRoute.ps1 script determines which Windows answer file in the as-repository folder belongs
to the server that is being provisioned. If desired, you can customize this script. However, when you add the
Bare Metal Agent to Cisco UCS Director, the script in the as-repository folder will revert to the default
script without the customizations.

Windows Answer File

The Windows answer file contains settings and values that are used during the deployment of a Windows
operating system. This answer file is typically named unattend.xml. During simultaneous deployment, a
separate Windows answer file is created in each MAC address folder and then sent to the server to be used
during the Windows operating system setup.

When the installation is successfully completed, the name of the answer file is changed to include "Completed."

For more information, see the Microsoft TechNet article on Understanding Answer Files.

Example: Simultaneous Deployment of Windows Server Operating Systems
This example describes what actions Bare Metal Agent performs when you execute two workflows at the
same time, with each workflow designed to provision a bare metal server with a Windows operating system.
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The illustrations below describe how server 1 and server 2 are provisioned when the PXE tasks in the workflows
are executed.

Figure 3: Server 1 Provisioning

When the PXE boot task is executed in the workflow that provisions Server 1, the steps shown in the above
illustration occur:

ActionStep

Server 1 boots up. The WinPE.wim file, together with its PowerShell packages and
Startnet.cmd, is copied to the server.

1

The Startnet.cmd calls the EnRoute.ps1 script from the /samba folder on the Bare
Metal Agent VM.

A folder is created under /samba/as-repository/with MAC address of Server 1 as its
name, for example, /samba/as-repository/MAC 1, and a Windows answer file is
placed into that folder.

2

The EnRoute.ps1 script compares the MAC address on Server 1 with the MAC address
folders available in the /samba/as-repository folder and finds the Windows answer
file for Server 1 in the /samba/as-repository/MAC 1 folder.

3
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ActionStep

Using theWindows answer file, the appropriateWindows operating system (shown asWindows
installation files) is installed on Server 1.

When the installation is successfully completed, the name of the answer file is changed to
include "Completed."

4

Figure 4: Server 2 Provisioning

At the same time as Server 1 is being provisioned, when the PXE boot task is executed in the workflow that
provisions Server 2, the steps shown in the above illustration occur:

ActionStep

Server 2 boots up. The WinPE.wim file, together with its PowerShell packages and
Startnet.cmd, is copied to the server.

The Startnet.cmd calls the EnRoute.ps1 script from the /samba folder on the Bare
Metal Agent VM.

A folder is created under /samba/as-repository/with MAC address of Server 2 as its
name, for example, /samba/as-repository/MAC 2, and a Windows answer file is
placed into that folder.

5
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ActionStep

The EnRoute.ps1 script compares the MAC address on Server 2 with the MAC address
folders available in the /samba/as-repository folder and finds the Windows answer
file for Server 2 in the /samba/as-repository/MAC 2 folder.

6

Using theWindows answer file, the appropriateWindows operating system (shown asWindows
installation files) is installed on Server 2.

When the installation is successfully completed, the name of the answer file is changed to
include "Completed."

7
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A P P E N D I X  A
Sample Operating System Configuration
Template Files

This chapter contains the following sections:

• Sample Linux Configuration Template Files, page 89

• Sample VMware vSphere ESXi Configuration Template Files, page 91

• Sample iPXE UEFI Configuration Template File for Windows, page 93

• Sample Windows Answer File, page 93

Sample Linux Configuration Template Files

Sample Kickstart Configuration Template File for Linux Operating Systems
The following example shows the Kickstart configuration template file (ks.cfg) that is required for Linux
operating system images:

#platform=x86, AMD64, or Intel EM64T

# System authorization information
auth --useshadow --enablemd5

# System bootloader configuration
bootloader --append="rhgb quiet" --location=mbr --driveorder=sda

# Partition clearing information
clearpart --linux --initlabel

# Use text-based install
text

# Firewall configuration
firewall –-disabled

# Run the Setup Agent on first boot
firstboot -–disable

# System keyboard
keyboard us

Cisco UCS Director Bare Metal Agent Installation and Configuration Guide, Release 6.5    
89



# System language
lang en_US

# Installation logging level
logging --level=info

# Provide url/location of image over http.
url --url=http://$PXE_NATIVE_WEBSERVER/image_name

#Reboot after installation
reboot

# Network information
network --bootproto=static --device=eth0 --ip=$PXE_IP
--netmask=$PXE_NETMASK --gateway=$PXE_GATEWAY
--hostname=$PXE_NAME --onboot=on

#Root password
rootpw $PXE_PASSWD

# SELinux configuration
selinux --disabled

# System timezone
timezone --utc America/New_York

# Install OS instead of upgrade
install

# Disk partitioning information
part / --fstype="ext3" --size=8000

#Install required packages
%packages --nobase
wget

%post
wget http://$PXE_WEBSERVER/$PXEID/notify.html

The following example shows the Kickstart configuration template file (ks-uefi.cfg) that is required for
Linux operating system images:

auth --useshadow --enablemd5
bootloader --append="rhgb quiet" --location=mbr --driveorder=sda
clearpart --all --initlabel

zerombr
ignoredisk --only-use=sda
text
firewall --disabled
firstboot --disable
keyboard us
lang en_US
logging --level=info
url --url=http://$PXE_NATIVE_WEBSERVER/IMAGECATALOGNAME
reboot
$PXE_DHCP_IP_TYPE network --bootproto=dhcp --device=eth0 --hostname=$PXE_NAME --onboot=on
$PXE_STATIC_IP_TYPE network --bootproto=static --device=eth0 --ip=$PXE_IP
--netmask=$PXE_NETMASK --gateway=$PXE_GATEWAY --vlanid=$PXE_MGMTVLAN --hostname=$PXE_NAME
--onboot=on
rootpw $PXE_PASSWD
selinux --disabled
timezone --isUtc $PXE_TIMEZONE
install

part /boot/efi --fstype=efi --grow --maxsize=200 --size=50
part /boot --fstype=ext3 --size=500

part swap --fstype="swap" --size=1024
part pv.01 --size=10240
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volgroup vg0 pv.01
logvol /home --vgname=vg0 --size=500 --name=home
logvol / --vgname=vg0 --grow --size=1 --name=root

%packages --nobase
wget
%end

%post

## Notifying back to Cisco UCS Director once the blade is up ##
wget http://$PXE_WEBSERVER/$PXEID/notify.html
%end

Sample PXE Configuration Template File for Linux Operating Systems
The following example shows the PXE configuration template file (pxe.cfg) that is required for Linux
operating system images:

default linux

label linux
kernel vmlinuz

append initrd=initrd.img ramdisk_size=9216 noapic acpi=off ip=dhcp ks=$PXE_KS_URL

prompt 0
timeout 0

Sample iPXE Configuration Template File for Linux Operating Systems
The following example shows the iPXE configuration template file (ipxe.cfg) that is required for Linux
operating system images:
default linux
label linux
kernel http://$PXE_NATIVE_WEBSERVER/$PXE_OS/isolinux/vmlinuz
append initrd=http://$PXE_NATIVE_WEBSERVER/$PXE_OS/isolinux/initrd.img ramdisk_size=9216
noapic acpi=off ip=dhcp ks=$PXE_KS_URL ksdevice=eth0
inst.repo=http://$PXE_NATIVE_WEBSERVER/$PXE_OS net.ifnames=0 biosdevname=0
prompt 0
timeout 0

Sample VMware vSphere ESXi Configuration Template Files

Sample Kickstart Configuration Template File for VMware vSphere ESXi
Operating Systems

The following example shows the Kickstart configuration template file (ks.cfg) that is required for VMware
vSphere ESXi operating system images:

vmaccepteula

#Set passsword for ESXi server, "$PXE_PASSWD" will be filled in by UCSD
rootpw $PXE_PASSWD
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#For Local boot, uncomment the following line
#install --firstdisk --overwritevmfs

#For SAN boot, uncomment the following line
install --firstdisk=remote --overwritevmfs

#Configures the mangement vmknic interface for the ESXi host. All items
starting with "$" are variables that will be replaced by UCSD during the
PXE boot process.

network --bootproto=static --ip=$PXE_IP --netmask=$PXE_NETMASK
--gateway=$PXE_GATEWAY --vlanid=$PXE_MGMTVLAN
--nameserver=$PXE_NS --hostname=$PXE_NAME

%pre --interpreter=busybox
hwclock -d %LIVE_VAR_DATE_1% -t %LIVE_VAR_TIME_UTC_1%
date -s %LIVE_VAR_DATE_TIME_UTC_1%
cd /tmp
wget http://$PXE_WEBSERVER/$PXEID/web/track/log1

%firstboot --interpreter=busybox
cd /tmp
wget http://$PXE_WEBSERVER_MGMT_VLAN_IP/$PXEID/web/track/log3

wget http://$PXE_WEBSERVER_MGMT_VLAN_IP/$PXEID/web/track/log4

#Enable & start remote ESXi Shell (SSH)
vim-cmd hostsvc/enable_ssh
vim-cmd hostsvc/start_ssh

#Enable & start ESXi Shell (TSM)
vim-cmd hostsvc/enable_esx_shell
vim-cmd hostsvc/start_esx_shell

wget http://$PXE_WEBSERVER_MGMT_VLAN_IP/$PXEID/web/track/log5

%post --interpreter=busybox --ignorefailure=true

cd /tmp
localcli network firewall set --default-action true
localcli network firewall set --enabled false
wget http://$PXE_WEBSERVER_MGMT_VLAN_IP/$PXEID/web/track/log2
wget http://$PXE_WEBSERVER_MGMT_VLAN_IP/$PXEID/notify.html -O /tmp/notify.html
localcli network firewall set --default-action false
localcli network firewall set --enabled true

#Power down the ESXi server after installation
poweroff

Sample PXE Configuration Template File for VMware vSphere ESXi Operating
Systems

The following example shows the PXE configuration template file (pxe.cfg) that is required for VMware
vSphere ESXi operating system images:

default image_name/menu.c32
menu title PXE Boot Home
timeout 70

label image_name
menu label Install VMware image_name
kernel image_name/mboot.c32
append -c /web/ks-repository/$PXE_ID/boot.cfg +++
IPAPPEND 1
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Sample iPXE Configuration Template File for VMware vSphere ESXi Operating
Systems

The following example shows the iPXE configuration template file (ipxe.cfg) that is required for VMware
vSphere ESXi operating system images:

default 1
timeout 100
prompt 1
label 1
KERNEL ipxe.lkrn
Append dhcp && chain http://$PXE_NATIVE_WEBSERVER/$PXE_WINDOWS_OS_REPOSITORY_LINK/boot.ipxe

Sample iPXE UEFI Configuration Template File for Windows
The following example shows the iPXEUEFI configuration template file (ipxe-uefi.cfg) that is required
for windows:

#!ipxe
kernel ../wimboot
initrd ../Boot/BCD BCD
initrd ../Boot/boot.sdi boot.sdi
initrd ../Boot/WinPE.wim WinPE.wim
boot

Sample Windows Answer File
The following is an example of a Windows answer file, named AUTOUNATTEND.XML, that can be used to
set up a Windows Server 2008 R2 OS image for use with Cisco UCS Director Bare Metal Agent.

<unattend>
<servicing>
<package action="configure">
<assemblyIdentity name="Microsoft-Windows-Foundation-Package" version="6.1.7600.16385"

processorArchitecture="amd64" publicKeyToken="xxxf3856ad364xxx" language=""/>
<selection name="IIS-WebServerRole" state="false"/>
<selection name="IIS-WebServer" state="false"/>
<selection name="Microsoft-Hyper-V" state="true"/>
<selection name="Microsoft-Hyper-V-Management-Clients" state="true"/>
<selection name="Microsoft-Hyper-V-Management-Clients" state="true"/>
<selection name="MultipathIo" state="true"/>
<selection name="TelnetClient" state="true"/>
</package>

</servicing>
<settings pass="windowsPE">
<component name="Microsoft-Windows-Setup" processorArchitecture="amd64"
publicKeyToken="xxxf3856ad364xxx" language="neutral" versionScope="nonSxS">
<ComplianceCheck>
<DisplayReport>OnError</DisplayReport>
</ComplianceCheck>
<Display>

<VerticalResolution>600</VerticalResolution>
<RefreshRate>60</RefreshRate>
<HorizontalResolution>800</HorizontalResolution>
<ColorDepth>32</ColorDepth>

</Display>
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<EnableFirewall>false</EnableFirewall>
<UserData>
<ProductKey>
<WillShowUI>Never</WillShowUI>
<Key>XXXXX-XXXXX-KQT8W-PMXWJ-XXXXX</Key>
</ProductKey>
<AcceptEula>true</AcceptEula>
<FullName>Cisco</FullName>
<Organization>CiscoUCSD</Organization>
</UserData>
<DiskConfiguration>
<WillShowUI>OnError</WillShowUI>
<Disk wcm:action="add">
<CreatePartitions>
<CreatePartition wcm:action="add">
<Order>1</Order>
<Type>Primary</Type>
<Size>40000</Size>
</CreatePartition>
</CreatePartitions>
<DiskID>0</DiskID>
<WillWipeDisk>true</WillWipeDisk>
<ModifyPartitions>
<ModifyPartition wcm:action="add">
<Active>true</Active>
<Extend>false</Extend>
<Format>NTFS</Format>
<Label>OS</Label>
<Letter>C</Letter>
<Order>1</Order>
<PartitionID>1</PartitionID>
</ModifyPartition>
</ModifyPartitions>
</Disk>
</DiskConfiguration>
<ImageInstall>
<OSImage>
<InstallTo>
<DiskID>0</DiskID>
<PartitionID>1</PartitionID>
</InstallTo>
<WillShowUI>Never</WillShowUI>
<InstallFrom>
<MetaData wcm:action="add">
<Key>/IMAGE/NAME</Key>
<Value>Windows Server 2008 R2 SERVERDATACENTER</Value>
</MetaData>
<Path>\\000.00.90.31\bits\sources\install.wim</Path>
</InstallFrom>
</OSImage>
</ImageInstall>
</component>
<component name="Microsoft-Windows-International-Core-WinPE" processorArchitecture="amd64"

publicKeyToken="nnnf3856ad364nnn" language="neutral" versionScope="nonSxS">
<SetupUILanguage>
<UILanguage>en-US</UILanguage>
</SetupUILanguage>
<UserLocale>en-US</UserLocale>
<UILanguage>en-US</UILanguage>
<SystemLocale>en-US</SystemLocale>
</component>
</settings>
<settings pass="specialize">
<component name="Microsoft-Windows-International-Core" processorArchitecture="amd64"
publicKeyToken="nnnf3856ad364nnn" language="neutral" versionScope="nonSxS">
<SystemLocale>en-US</SystemLocale>
<UILanguage>en-US</UILanguage>
<UILanguageFallback>en-US</UILanguageFallback>
<UserLocale>en-US</UserLocale>
</component>
<component name="Microsoft-Windows-TerminalServices-LocalSessionManager"
processorArchitecture="amd64" publicKeyToken="nnnf3856ad364nnn"
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language="neutral" versionScope="nonSxS">
<fDenyTSConnections>false</fDenyTSConnections>
</component>
<component name="Microsoft-Windows-Deployment" processorArchitecture="amd64"
publicKeyToken="31bf3856ad364nnn" language="neutral" versionScope="nonSxS">
<RunSynchronous>
<RunSynchronousCommand wcm:action="add">
<Description>Disable IPv6</Description>
<Path>reg add HKLM\SYSTEM\CurrentControlSet\Services\tcpip6\Parameters /v DisabledComponents
/t
REG_DWORD /d 255 /f</Path>
<Order>1</Order>
</RunSynchronousCommand>
<RunSynchronousCommand wcm:action="add">
<Description>Disable Shutdown Tracker</Description>
<Path>reg add "HKLM\SOFTWARE\Policies\Microsoft\Windows NT\Reliability" /v ShutdownReasonOn
/t
REG_DWORD /d 0 /f</Path>
<Order>2</Order>
</RunSynchronousCommand>
</RunSynchronous>
</component>
<component name="Networking-MPSSVC-Svc" processorArchitecture="amd64"
publicKeyToken="nnnf3856ad364nnn" language="neutral" versionScope="nonSxS">
<DomainProfile_EnableFirewall>false</DomainProfile_EnableFirewall>
<PrivateProfile_EnableFirewall>false</PrivateProfile_EnableFirewall>
<PublicProfile_EnableFirewall>false</PublicProfile_EnableFirewall>
</component>
<component name="Microsoft-Windows-ServerManager-SvrMgrNc" processorArchitecture="amd64"
publicKeyToken="nnnf3856ad364nnn" language="neutral" versionScope="nonSxS">
<DoNotOpenServerManagerAtLogon>true</DoNotOpenServerManagerAtLogon>
</component>
<component name="Microsoft-Windows-OutOfBoxExperience" processorArchitecture="amd64"
publicKeyToken="nnnf3856ad364nnn" language="neutral" versionScope="nonSxS">
<DoNotOpenInitialConfigurationTasksAtLogon>true</DoNotOpenInitialConfigurationTasksAtLogon>

</component>
<component name="Microsoft-Windows-powercpl" processorArchitecture="amd64"
publicKeyToken="nnnf3856ad364nnn" language="neutral" versionScope="nonSxS">
<PreferredPlan>8c5e7fda-e8bf-4a96-9a85-a6e23a8c635c</PreferredPlan>
</component>
<component name="Microsoft-Windows-Shell-Setup" processorArchitecture="amd64"
publicKeyToken="nnnf3856ad364nnn" language="neutral" versionScope="nonSxS">
<ComputerName>*</ComputerName>
<ProductKey>XXXXX-XXXXX-KQT8W-PMXWJ-XXXXX</ProductKey>
</component>
</settings>
<settings pass="oobeSystem">
<component name="Microsoft-Windows-Shell-Setup" processorArchitecture="amd64"
publicKeyToken="nnnf3856ad364nnn" language="neutral" versionScope="nonSxS">
<Display>
<ColorDepth>32</ColorDepth>
<HorizontalResolution>800</HorizontalResolution>
<VerticalResolution>600</VerticalResolution>
<RefreshRate>60</RefreshRate>
</Display>
<OOBE>
<HideEULAPage>true</HideEULAPage>
<HideWirelessSetupInOOBE>true</HideWirelessSetupInOOBE>
<NetworkLocation>Work</NetworkLocation>
<ProtectYourPC>3</ProtectYourPC>
</OOBE>
<VisualEffects>
<FontSmoothing>ClearType</FontSmoothing>
</VisualEffects>
<WindowsFeatures>
<ShowInternetExplorer>true</ShowInternetExplorer>
</WindowsFeatures>
<TimeZone>Pacific Standard Time</TimeZone>
<RegisteredOrganization/>
<ShowWindowsLive>false</ShowWindowsLive>
<UserAccounts>
<AdministratorPassword>
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<Value>987654321abc???=</Value>
<PlainText>false</PlainText>
</AdministratorPassword>
</UserAccounts>
<AutoLogon>
<Password>
<Value>123456abc???</Value>
<PlainText>false</PlainText>
</Password>
<Enabled>true</Enabled>
<LogonCount>1</LogonCount>
<Username>Administrator</Username>
</AutoLogon>
<FirstLogonCommands>
<SynchronousCommand wcm:action="add">
<CommandLine>cmd /c winrm quickconfig -quiet -transport:HTTP</CommandLine>
<Description>Enable WinRS over HTTP to communicate with CPA</Description>
<Order>1</Order>
<RequiresUserInput>false</RequiresUserInput>
</SynchronousCommand>
<SynchronousCommand wcm:action="add">
<CommandLine>cmd /c winrm set winrm/config/client @{TrustedHosts="*"}</CommandLine>
<Description>Adding trusted hosts value for winrm client</Description>
<Order>2</Order>
<RequiresUserInput>false</RequiresUserInput>
</SynchronousCommand>
<SynchronousCommand wcm:action="add">
<CommandLine>cmd /c net use R: \\000.00.90.31\bits /user:smbuser cisco123</CommandLine>
<Description>Mapping the share to save the notification file</Description>
<Order>3</Order>
<RequiresUserInput>false</RequiresUserInput>
</SynchronousCommand>
<SynchronousCommand wcm:action="add">
<CommandLine>cmd /c ipconfig /all | findstr "Physical" >>
R:\notifications\completed.html</CommandLine>
<Description>Writing the completed notification log with MAC address at
Share mapped in previous step</Description>
<Order>4</Order>
<RequiresUserInput>false</RequiresUserInput>
</SynchronousCommand>
<SynchronousCommand wcm:action="add">
<CommandLine>cmd /c R:\notifications\completed.bat</CommandLine>
<Description>executing powershell batch file like as wget</Description>
<Order>5</Order>
<RequiresUserInput>false</RequiresUserInput>
</SynchronousCommand>
</FirstLogonCommands>
</component>
</settings>
<settings pass="offlineServicing">
<component name="Microsoft-Windows-LUA-Settings" processorArchitecture="amd64"
publicKeyToken="nnnf3856ad364nnn" language="neutral" versionScope="nonSxS">
<EnableLUA>false</EnableLUA>
</component>
</settings>
<cpi:offlineImage cpi:source="wim:D:/win2k8r2x64sp1/sources/install.wim#Windows
Server 2008 R2 SERVERDATACENTER"/>
</unattend>
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A P P E N D I X  B
Ports

This appendix contains the following sections:

• Cisco UCS Director TCP and UDP Port Usage, page 97

• Port List, page 99

• Multi-Node Port Requirements, page 101

Cisco UCS Director TCP and UDP Port Usage
This section provides a list of the TCP and UDP ports that Cisco UCS Director uses for connections and
communications with external applications or devices. The port usage depends uponwhether you have deployed
Cisco UCS Director on VMware vSphere or Microsoft Hyper-V.
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Cisco UCS Director TCP and UDP Port Usage on VMware vSphere
The following figure shows the network ports used for communication between the Cisco UCS Director
appliance andmanaged devices, ESX servers, BareMetal Agent, PowerShell Agent, NTP, and Active Directory
for an installation on VMware vSphere.

Figure 5: Cisco UCS Director TCP and UDP Port Usage
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Cisco UCS Director TCP and UDP Port Usage on Microsoft Hyper-V
The following figure shows the network ports used for communication between the Cisco UCS Director
appliance andmanaged devices, ESX servers, BareMetal Agent, PowerShell Agent, NTP, and Active Directory
for an installation on Microsoft Hyper-V.

Figure 6: Cisco UCS Director TCP and UDP Port Usage

Port List
DescriptionProtocolDefault Port

SSHTCP22

HTTPTCP/UDP80

HTTP for Cisco UCS Director Bare Metal AgentTCP8888

TFTP for Cisco UCS Director Bare Metal AgentTFTP69

HTTPSUDP443

Citrix licensingTCP27000/7279/8082 (Mgmt)

Virtual Desktop Agent for DesktopsTCP2598/1494/2112/2513

DHCPUDP67/68
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DescriptionProtocolDefault Port

Active DirectoryTCP/UDP

TCP

389/636

3268/3269

DNSTCP/UDP53

NTPTCP/UDP123

MySQLTCP/UDP3306

Cisco UCS Director + VNC ConnectivityTCP8787/5900-5964

Cisco UCS Director + RDP ConnectivityTCP/UDP3389

Cisco UCS Director + NetApp ConnectivityTCP/UDP80/443/8080

Cisco UCS Director + Cisco UCS Manager
Connectivity

UDP80/443

Cisco UCS Director + vCenter ConnectivityUDP80/443

RDPTCP/UDP3389

SMB/RPCTCP135/445

KerberosTCP/UDP88

NetBIOS Name (nbname)TCP/UDP137

NetBIOS datagram (nbdatagram)TCP/UDP138

NetBIOS session (nbsession)TCP139

Desktop Delivery Controller <--> vCenterUDP80/443

Desktop Delivery Controller <--> Virtual DesktopsTCP8080 through ICA

Users (Citrix Recvr) <--> Virtual DesktopsTCP1494/2598/2512/2513

Desktop Delivery Controller <--> Active DirectoryTCP/UDP389/636 (LDAP Ports)

Virtual Desktops <--> Active Directory + DNSTCP/UDP389/636, 3268/3269, 53

PowerShell Agent <-> Xendesktop through WinRMTCP5985/5986

Cisco UCS Director <--> PowerShell AgentTCP/UDP43891

XenAppTCP80/8081

   Cisco UCS Director Bare Metal Agent Installation and Configuration Guide, Release 6.5
100

Ports
Port List



DescriptionProtocolDefault Port

VMwareESXi host management andVMcustomization
and to execute VIX tasks

TCP902

VMwareESXi host management andVMcustomization
and to execute VIX tasks (for Vmware vCenter releases
prior to 5.0)

TCP903

Multi-Node Port Requirements
The ports listed in Cisco UCS Director TCP and UDP Port Usage, on page 97 are applicable for both single
and multi-node setups.

For a multi-node setup, the following ports must be opened between the nodes:

• From the primary and service nodes to database nodes: port 3306

• From the primary node to service nodes: ports 80 and 443
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